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VTN E—T oA ATT, v T A2 —T oA RAEFEMTHE, NI EINTD
MDA 4 —7 A A) EtherChannel DS EIEH T& £97,

I L HE—T A A1,

WER LMD G DRy PU =7 IZ 1 BOAA v FRH Y £,
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B /o235 1-vror—TLEge7y TR N —LBEUSIVR MY —LBEDRTE

ASA2 ASA4
ammmms!
w o0 o w =] o [« ] §=]
SEEHE RS S s| 315(3(3|3
[y O el B el Y wl  o = = = [l el Bl [
Q|| | D © 1] (] [ DD D] D) ©
Cluster ~T B
Control Link _._.> ( < )
port-ch1 port-c port-ch1
| | .-
port-ch2.200 Inside VLAN 200
port-ch2.201 Outside VLAN 201
VLAN 101 port-ch2 port-ch3 port-ch4
port-chi
g D ==
port-ch5 3
Inside VLAN 200 Management é
Outside VLAN 201 VLAN 100
Trunk

B8 4 5D% ASA DHERRA V3 — | R4 v F R— kA

JxA4 R

77 ALY o TenGigabitEthernet 0/6 33 LY | &5t 8 AR— b

TenGigabitEthernet 0/7 o

TenGigabitEthernet 0/6 &

TenGigabitEthernet 0/7 D=7 =

L1z, 4 {#® EtherChannel
(ASA ZEIC1EDEC) &K

ELET,

Z U5 @ EtherChannel 9-X T
M. [Fl— DML 7 T A X H
VLAN | (7= & 21X VLAN

101) ICFETDIRENLHY £
—j—o
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YR8 — 1=y rTDH5R4 1 v8—T 1142 E—FOEE [

Sl

45D% ASA DiEfEA 52—
JxM4 R

AL YF R—b~

PNESB LU A v 4 —T =
S£ 2

TenGigabitEthernet 0/8 33 X T
TenGigabitEthernet 0/9

b8 A=k

Bi— @ EtherChannel %% L
FT (TRTOASAIZE =N
%)

AA »FTlE, ZTD VLAN I
SOy hU—2 % Z Z T
ETEET, =& xiE, VLAN
200 (NEH) 3 X OV VLAN
201 (AMEBH) NEEND b T
VI ERELET,

BHA L H—T A R Management 0/0

AE 4 FK— b

TRCDOA L H—T A A
%, [Al— O B VLAN
(7= & ZIZVLAN100) EiZE
xFET,

YRARBZ—AZYFTDI SR AVEA—T A X E—FDERTE

IS5 ARY T RICBRETCEXAL X —T oA ADHX A S L. A3 K EtherChannel & {fz] A
VE—T oA ZADNTNIN—FDHTT, 12DF TAENTA L E—T =2 AZA T HIRIE
SHHZLIITEERA,

A\

GE)

VAL — 2=y FPHAL—T 2=y MBI LARWEEER, vAY— 2=y 2T TR
P2y DA H =T 2 A A E— FEZOHOFHRAIZHES TFHTRETILERHY £
T, YAX— 2=y ML ACFY 2=y FEBNT5581E. ASDMABAAL—7 2=
DA E—T 2 A A F— REZHBICHRTE L X7,

1R BHEIIZ

EHERA X —T 2 ATNOTH, #RA S H =T A A (EEE) L L THRETEE
9 (A/%r KEtherChannel E— KD & xCTH) , BHA X —7 x4 A, HBIA X —
T2 A AETHRZENTEET (M UVAXT VLU N T AT U4 — /L E—FRDEET
H)

e 2% R EtherChannel — R TlX, BHA L 2 —T oA Z5BIA L Z—T =2 A 2 & LT
RETHE, BHA LV —T 2 ALK L TCEATFT I v I N—TFT 4 T A X—TWIT
EFEHA, AXT 47 V— b EHEHTAILERDHY £7,
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AsAY 524 |
ABALUB—T AR E—FDORE

e LF aLTHFANET—RTHEH., TRTCOITHFRAMNIKFLTL DO L E—T = A
AR TERINTDMLENDY FT, 220X, FTFUAXT LU N E—REL—T v
RE—=ROaTHFAIBRMELTVWDEAIL, T XTOa s TF A MIANRSR
EtherChannel ©— RZ M HT 2 LERH Y £3, Zhn, T AXT L2 FE— FTiHF
TENIME—DA LB —T 2 A A ZA T THDHNSTT,

FIE

ATv 71 In

ASDM on the master unit, choose Tools > Command Line Interface. A ¥l D 72\ a7 ¢ F =2

L—arEaFRL, BHc,A v 4 —T 2 A AE—RIZLTHE Ty 74 X2l —a’k
BEETZA2L5CLET, Z0avwy RTCIEE—FREIEEINEHA,

cluster interface-mode {individual | spanned} check-details

1 :

@no Command Line Interface

ATvT2 7

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prompt for confirmation, add an appropriate noconfirm option as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command

(*) Single Line Multiple Line [ Enable context sensitive help ()
cluster interface-mode spanned check-details e
Response:

Result of the command: "cluster interface-mode spanned check-details"

ERROR: Please modify the following configuration elements that are incompatible with ‘spanned' interface-mode.
- A cluster IP address pool must be specified on interface Gi@/@(outside). Or remove IP address configuration.

= A cluster IPF address pool must be specified on interface Ma@/@(management). Or remove IPF address configuration.

Clear Response

Help Close @

E A B =Tz AAE— RERE LTZRIL, A Z—T A AT TED L DIT
ROET, L, 7 T7AZ Y TEMRGEHAT AL ICEEA X —T o A
ETDHENCASAZ Y B —RT5E (22X 7 IAXPT—VEZBNTLH2D) |
IS AR L BERNEDRNA L E—T 2 A A AT fFal—a BRI ENA T
W, FERETE R RV ET, ZTOHAE, 2 YL R— MIERHRLTA v F—
T2 A AT 4 X2l —a VEEETLILERSHY £,

FGAXY TR v H—T 2 A ET—FRERELET,

cluster interface-mode {individual | spanned} force

&1
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2RA—21=y rTDI5R2 A v8—T7142 E—F0EE ||

@no Command Line Interface

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prompt for confirmation, add an appropriate noconfirm option as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command
(*) Single Line Multiple Line [ Enable context sensitive help ()
cluster interface-mode spanned force e
Response:

Result of the command: "cluster interface-mode spanned force"

WARNING: Cluster interface-mode is changed to 'spanned' without walidating compatibility of the running configurat

Clear Response

Help Close

TNV IIRTEIEH Y EEA, HARMICE— FE2ERTILERH YV ET, T—FREZHRTLT
WRWEARE, 7T AX D T A X—TNIZTEERE A,

force 7> a VEAIRET D &, HEMEDORWa Ly 7 4 X2 L— g COREIIITHOTICE—
RPREEINET, a7 Xalb—a  OfERDLIHEAIE, T— FE2EHE LRI TE
TR HAVLERHDVET, (v F—T oA A A7 4 Fal— g OBEERTXSHDIT
F— FOHRERBIZIEONDDT, force 7> a L EHATAHZEZHRLET, 2L
THE, KIETH, BEOa 7 4 X2 b—3 g VORENSHBTEET, EbiThA 4
ADRMBEIRGEIL, T— FEFHIE L721% T check-details 77> 3 V2 HEITLET,

force 77> a U EIBELRWE, BHMEOR NI T 4 X2 L —2a U RHLIBRAIE, v
TA4X 2l —varE 7T LTI —FRTHLROENDDT, ar ) —/LR— MNIHE
L TEIET 7B AZHRETIMLERHY £3, 2307 0 Fab—r a3 VIZHBMEOREN
RWEARIE (EZer—R) | FE—FKBREFEIN, 274 Fab—v g UidfERanEd,
AT 4 Xalb—varEZ VT LEL WG, nZ AL TCa~vr REKTLET,

A B =T A A FT— REMERT AI21%. no cluster interface-mode =~ > K& AL £,

ATYFT3I ASDMZKTL, Va—KLEd, V7 I7AX A X —T 2 AE—RIZELIFIETDH LD
IZ ASDM Z FEEI¢T 2 0B R H D £9, U a— ROk, &—2L5 =12 [ASA Cluster] ¥ 78
FRINET,
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B ootz <7 007520 T—FTRLA) RRE— 12y FTOAVE—T 14 RAORE

Device Information

| General = License

Cluster Interface Mode: Spanned EtherChannel

Cluster is not enabled.

Details

(#2E, YILFAVTIXFRAFNE—FTEBE) YREZ—2=ZY FTOA 3 —T A

ADEHTE
T AR T AT HENC, BEIP T RLARHKRESNTWDEAS v X —T = A%V
TASFINCEE T 20BN H Y 9, V< &b, ASDM BHIEER SN TV EH A
H—T 2 ALBERBTIHIVLERNHYET, oA X —T A RTONWTIE, FTAX) T
BAF—TMITHAELII LB CTRETEET, Be&Rhary 74 Fab—vayBHiLn
I TGABANERAT DL, TRTOA U F—T oA AZFHFNIRET DT L EHELEL
9, vAF arTHFALE—RTIE, ZOHEOFELFEH LT, BHFEOA X —T =1 A
EEET DL, LAV F—T 2 AERETDHVLERDY T, —FH, VI NLE—FRT
X, ZOIEEAME L. High Availability and Scalability 7 ¢ ' — K CIHil A v ¥ —T7 = A4 X /XF
A—BERETEET (@EAAEOY P —RFDFET (573—) 2M]) , @A 2 —
7 = A A ® EtherChannel DIERK 72 EDEERA L B —T = A AREITY 4 F— R TITETT
RN LIZERL TSN,

CITIE IV TARZ VT HBL IR D LA v E—T oA RAERET D HEICOW T L
9, T—H A H—T A AL, A% K EtherChannel & L CHRETHZ &8, HBIA >~
=Tz A AL LTHETHIEHTEET, FHFRIOR— KT T A=A L%
FHLES, RCar7 s Fal—a CMFOIATERETHZLITTEERA, 22
L., BHA ¥ —7 = A ZNIFIJ T, A3 K EtherChannel & — K Toh o> THEBIA o & —
Tz A AZTEET,

BRADA B —T A ADHRE (B 58 —7 4 RIZHERE)

ARA v H =T =2 ATBEEDONLN—T v R A L H—=T =24 ZATHH, TNETUNHEHADIP T
RLAZIPT RLVA =M BELET, AAM LV 7TAXIPT RLAE, FOTTAX
DIZHDEET RLATHY, HICHEDT 74~ 2=y MIBLET,

2% K EtherChannel ®— K TiE, BHA L X —T =2 A RAZHRIA L F—T =24 AL LTHE
THZEAMELET, [EEERA X —T = AR5, LB TE =y MIEEEE
e CEx £33, A% FEtherChannel f > % —7 = A A TlL, BFEDOTTIA < 2= h~D

BERE LT £ AL

i B B
EBEMA S =T = A ADBEERE | YA S —T = AT KT S T L BLE
ST

. ASAY S R4
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BAHDOA v s —T 1 2OBRE (FEsvs—Tz4R#R) |

N TF AT XA T—ROHAIF, ZOTFIEEKE I THFANCTETLEYS, £
VTXRARN AT 4 FXal—Ta s E— RIZAS TWRWEAIL, changeto context name
o< K& AJJL%E7, [Configuration] > [Device List] A > T, T 7T 4 T 72T /34 AD
IP7 RLADFIZHDLAVTHRANEL TV Y v 7 LET,

AERA L H =T 2 A ADGEIT, RAN=T N, ATOR— R NRNF U T R2HRET D
VENHD 7, FEHA X —T oA ZAZIE, MO — R AT ZIIEH ) F8
oo

s (FFvary) A B —T A A%T /A A v—/LEtherChannel f % —7 = A AL L
THETDH, MEAVE—T oA AERETDH, BIOVTA U F—T oA AERET D
YEZE A VBTN U TITWET,

« EtherChannel D34, Z @ EtherChannel (X = MIXtLTr—HLTHY, A
R EtherChannel TiZd ¥ FH A

EHHEPA LA —T 2 A ABTNEA VI =T oA AT HZ LT TEERA,
cASDMZEA L CERA X —7 = A ATV T— MIEEF L CWAIEAIE., kol
AU 2=y FOBIEDIP 7 KL A T—F2 s DT,

e FAUNIIE, TTAY 2=y R TERSINTEZ TAZIP S — NG IPT RLA
DEY B THNET,

o 7T AKIP =ML, RO EDLFZVIPT RLRAEET, 2y NI —2TT T
WHEATOT7T RLAEEDBZ LiTTEERA,

WIZHlZ R LU ET,
1. 794~V 2=y MZ101.1.1 ZEELET,
2. fho==- MZiE, 10.1.1.2, 10.1.1.3, 10.1.14 ZHEH L £,

3. 794~ 2=y hDIFTAZDIP SV ERETLHEES., FHRFTHLH-D
122, 3. ADT RLAZTF—NIZEDHZ LITTEEH A,

vz, 5. 6..7. 8DLEH%, Xy hI—7DMOIP 7 RLAEFHHATS
VBN H Y F9,

A\

GE) 7= dE, TIA~) 2=y bEFDRI TRAZDA LD
7 RUVARKETT, GO AT RVRFAAL L JFAZIPT R
VATHY, BIIEOT 74 <) 2=y FOHL DT,

>

5. JITAFIZEBMNTDEHEN—BERRT FLAIRES N, OB ciifcE £
‘a_o
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FIE

AT 71 [Configuration] > [Device Setup] > [Interface Settings] > [Interfaces] ~31{ > % &R L £9°,
ATV T2 A H—T oA AfTHBINLT, [Bdit] 27 Vv 7 LET, A VX —T A ADNRT A =K%
RELET, ROHTA RTA4 U EZBZRLTITZIN,

« (A/X2 K EtherChannel &€ — ROEH A ¥ —7 = A A TIWZ) [Dedicate this interface
to management only] : 1 ¥ —7 = A AZEHEHE— NHELTINT 7 1 v 7 N8l
LWL LET, 774V hTlE, BEIATOA 0 Z—T = RATEHEHFHE LT
RESNET, NTUART LU RN E—=RTHE, Z0avy NIEHYA 7O 07—
7 =2 A ZTH L THEICA X—=T 272 ) £,

« [Use Static IP] : DHCP & PPPoE [IH 7R — kSt A,

AFYT3 IPVAY T AZIP 7—/b, MACT RLZ 77—, BLXUOH A FBIOMAC T RLAZBINT5

121X, [Advanced] # 7% 27 U » 7 LT, [ASA Cluster] = VU 7 /XT7 A —H ZZE L £,

a) [IP AddressPool] 7 4 —/V ROKRIZH D L] ARF L Z 7 Vv 7 LTI FAXIP T— L&
L E, #RENDEREPIL, [General]l # 7 THRETHAA L IP T KL AIZX ik
ELET,

b) [Add] &7V 7 LET,

) AAY I TAEZDIPT RLAEEGERWT RLAFHARELET, *v hTI—2NHNT
BEERAEN TS T FL AL EAET A, @HIT, 72 2E8T7 FLAEWND K IIT,
7T AZDYA RGO THRIRELSTLILERH D £,

ano Add IPv4 Pool
Name: inside_pool
Starting IP Address: | 192.168.1.2 D
Ending IP Address: | 192.168.1.9 [_]

Subnet Mask: 255.255.255.04 :'

Help Cancel OK |

FANe4

d [OK]%#Z7 Uy 27 LT, LT —EERLET,
e) TERL7=H LW — L &BINL T, [Assign|Z2 27V v 7 L, KICOK] 227 U7 LET,

7 — V478 [IP Address Pool] 7 « —/V RIZFE/RENET,

) (EE) (F7var) MACT RLAZFETHRET %A 1E. [MAC Address Pool] %
HELET,
ATV T4 IPV6 7 RLAERET DI, [IPv6]| X727V v LET,
a) [Enable IPv6] = v 7Ry 7 A& AN LET,
b) [Interface IPv6 Addresses] =V 7 C, [Add]| &#2 U v 27 LET,

[Enable address autoconfiguration] 47" = AR — hENF A,

. ASAY S R4



| AsAv 524
R8> K EtherChannel D% E .

[Add IPv6 Address for Interface] % 4 7 2 7R 7 ANEKRSIVET,

¢) [Address/Prefix Length] 7 4 —/L R{Z, 72—/ )L IPv6 7 KL AL IPv6 SV T (v 7 AD
ESZANLET, 72&%01E. [2001:0DB8::BA98:0:3210/48] DL HIZ AT LET,

d) [LIJRZ %27 Vv LT, VFAZIP F—LE2RELET,

e) [Add| %7V v7 LET,

ane Add IPvE Pool
Mame: inside_ipw6_pool
Starting IP Address: 2001:DB8::1002 =
Prefix Length: 32

Number of Addresses: BI

Help Cancel | OK

) T—AOBMIPT KL A (Ry NU—7 LT 4w 7 R) | TvT7 4y 7 RAE, T KL
ABERELET,

g [OK]%Z7 Uy 27 LT, LT —EERLET,

h)y TERL7=H LW — L &R LT, [Assign| 227V v 7 L, KIC[OK] 227 U2 LET,

[ASA Cluster IP Pool] 7 4 —/L RIZF—LinFoRrEN £,
i) [OK]ZZ7 VU >7 LET,

ATw 75 [OK] %727 U7 LT, [Interfaces] A VIRV £7°,
ATY 76 [Applyl 227 U v/ LET,

Z /X2 K EtherChannel D% E
2% K EtherChannel (%, 7 7 AZNDTXTDASAIZIANR D H D TH Y . EtherChannel D&
ED—EE L Ca— R RT3 BT 2 ENTEET,
1R BHEIIZ
o A% K EtherChannel f > Z—7 = A A E— NIZTAHAXLERH Y £77,

e NTF AT XA FT—ROEFHIF, ZOTFIEE AT KAETAR—ATHIBELET,
FREVAT AL AT 4Falb—Tar = RICA> TWRNGAIL, [Configuration] >
[Device List] A > C, 77T 4 77T /34 ADIP T KL AD FIZH 5 [System] & & 7 /L
7V w7 LET,

e hFUANXT LU N BE—FROEAIE, TV vV IA—TERELET, 7V v AL
vHE—=T7 x4 A BVI) OFRTEZSRL T IEIN,

» EtherChannel |ZIZ KB L OOV 7 HAEETE LW TL 2 &V, EtherChannel D fx
KRBEORANDY 7 EDFREIT, ASAL AL v FDELLIZBWTHIThRWNT & &4
[BLET, INOEFEHTIMLENRD DA, RORIZEELTLEEN,

ASAY S R4
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AsAY 524 |
. Z /%> K EtherChannel D% 5E

e ASA FTHREEND Y 7 DOBRKREIZ., VI AZEIKOT 75 4 7 R— s DK
T, AA v F ETHREISNTRERY V7 HOMEN., ASA TOEEZEZ TWRNT &
FHERL T 722,

s ASA ETCEHRESINDIH/NY VI EIE, A= TF ¥y RNV A F—T oA ABLENT D
T2ODORNT 7T 47 R— b (2=y v HED) T, A v»F ETHEH, &V >
IEIT T T AZRERORNY I THhDHIED, TOfEIXASA TOEEIT—FH L E
A,

T TANIDOR—=RRT T T Y ALEEELRNTLIZEN, A v F T,
7L =3 X L source-dest-ip 7213 source-dest-ip-port (Cisco Nexus OS 35 J U8 Cisco 10S
@ port-channel load-balance =~ > R &) ZfiHT 52 LB LET, 7T X%
WD ASA D b T 7 4w 7 DEFEIZGRSNRLKRD T END D2, m— T
VTR XATHE, vlan F—U— REFH LRNTL ZE0,

« A% R EtherChannel ZfiH L CWA A, 7T AKX Y VI MNERIIA X—T N7 D F
T, "= F ¥ RN A Z—T oA RIRHF LETA, ZOBEMHICLID, 7 TAXDT Y
T4 T TRV MM T 7 4 v I NEREIND DN NET,

FIE

AFYvT1 arvFFAFE—FRZLoTROLIITELY £,

o 7V E— ROEE, [Configuration] > [Device Setup] > [Interface Settings] > [Interfaces] <2
A 2R T,

s v T E— ROGFE, VAT LAFEITAA—RXT, [Configuration] > [Context Management] >
[Interfaces] ~A > ZHR L £ 7,

AT v 72 [Add] > [EtherChannel Interface] DJEIZER L £,
[Add EtherChannel Interface] % A 7 2 7R v 7 ANRFREINE T,
ATYT3  WEAX—TMILET,
* [Port Channel ID]

* [Span EtherChannel across the ASA cluster]
* [Enable Interface] (77 #+ /L h CTA I/ £9)

+ [Members in Group] : [Members in Group] UV A M2, A > X —T = A ZA%&/D7p LH 128
MTHMERHY 7, 2= N T EIZEBEDA % —7 = A A3 EtherChannel |25 F 41
TWb &, VSS 72T VPC DAL v FICHf T 2 /AL L £ 4, 77 40 kT,
TIGAADERANTERRI6EDT 7T 4T A X —T x4 AD I B, AN R
EtherChannel 23 TE 2 DIE8{ETZIT THD Z LITHEE LTSI, HV DA X —
T oA AL I BEERFOZDDALX NATT, 8EIVE DT IT 47 A X —
TxA AEMMT 21T (TR LAZ N, A Z =T = ZATERL) | FAFIv7
R=KTIFA4F VT 42T 48—TNMILET, ¥A4FTIv I A=K TFIF7A4F VT 1%

. ASAY S R4
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ATv74

ATvTh

R8> K EtherChannel D% E .

TAE—=TNMITDE, VIR BKRTRRNRBEOT 77407 Vo7 A TEET,
72 2E, I6BEDASAMNBRD 7 T AXDEAIT., %5 ASA THRR2EHOA L F—T = A
2 EMFHTE, A3 R EtherChannel D&EHI 2 A v Z—T A4 A0 £,

TRTOAS L H =T 2 A ANFE LA T ERETHD LI LET, BHNEMT B A1
H—7T7 = A RZ L o> T, EtherChannel D% A 7L HENIED 9, —FHLABWNA L F—
Tz AREBMTDHE, Z2OA U H—T oA AXEILKREEIZ/Z2 Y £9, ASDM TlE, —#
LA X —T = A ZADEBIMIBHIESNEH A,

COBEEDOEY DT 4 —V NiX, ZOFIEHOBZF-THALET,

(A7 ar) §RTCDALNR—= AL B =T 2 ATONWT, AT 4T 447, —H#E.
WA, Te—floR—X 7 L —A% EEZ T 5ITIE, [Configure Hardware Properties] 7 U >
JLET, TNOLDORTA—FTF X XN ITN—T DT RCDOA LV Z—T =2 AT—HLTW
HZUMENRDH DT, TOFEEIINGDNRT A =R E2FZETHa— by M ET,

[OK] %7 U v 7 L T [Hardware Properties] DT &5 17 AivE T,

MAC 7 RLABI AT v a v NI A—ZEFET HITIL, [Advanced] ¥ 7% 7 U v 7 LE
7

* [MAC Address Cloning] f83% C. EtherChannel ® F#)j2/ 27— 3L MAC 7 RL A% E L E

T, AZUNAL MACT RLAZHRELRWNWTL &N, EHENET, BEMRE Y B
U — 7 OHEGRIE % BT 5 72912, A3 K EtherChannel (12137 @ —/ )L MAC 7 K L
AEHRETIHIVNENHY E4, MACT FLARFHRESHTWDLHEE. £DOMAC T
RUVARBEO~ AL — 2=y MIEEV £, MACT RLAZEEL TWRWEE
W2, AZ— =y MPREREINTEHE, FILDWvAY — 2=y MNIAVF—T A A
WHLWMAC Y RLAZBEHLET, ZHUTED, —RiRxR Yy MU —27 OFIRNIEAE
THAREMERH D T,

CNANFALTHEAPE—RTIE, I0TFR TS V2 —7 oA AT HEAIT,
MAC 7 FLZADBEAERZANI LT, FEITMACT FLAZRE LR T LD
CLET, A =T oA ZOYEE, ZOa~vr REEHLTMAC T KL 2%
TFHCTERETHODVENDDZ EICEELTLLIEEN,

s (=T v RE—NK) A NEZ TAZ Y 7 O4A . [ASA Cluster] fHI T, ¥4 ~E
FAOMACT FLRABIOIPT RLAZRET D720, [Add] 227 Vv 27 LT, ¥4
ID (1~8) OMACT RLABLIOIPT FLAZRELET, K8 D)1 FTLE
DFIEZ#VIKLET, VA4 MEADIP T FLRZ, Z7o— LIPTY RLREEUHT
Ay M EICHDIVERDHY £T, 2=y NTHEHATLY A FMEAFD MACT FL 2B IW
IP7 RLRAZ, Ba=y DT = ATy T a7 4Fab— g JTHEELLYA
FIDIZK > TR T,

o (X7 Ta) VSSEIXVPC D2 HEDAAL v FIT ASA 423 554 1%. [Enable load
balancing between switch pairs in VSS or vPC mode] = v 7 AR v 7 A% A 12 LT, VSS
B—=RNRT o T X—TMITHMENHY £9, ZOERELMEMT 5L, ASA
& VSS (F72ILvPC) X7 L DRIOWIRY v 7 it DA BRI SN E T,

[Member Interface Configuration] fE3C, 1 721X 2D EL LD AL v FITRFEDA > ¥ —
T oA AEPHRT DI ERET HDMENDH Y 7,
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ATvT6

ATy T1

ATvT8
ATvT9

ATy 710

ATy N
ATvT12

ATy 713

AsAY 524 |

P

X JE

(G¥)  [Minimum Active Members] & [Maximum Active Members] [Z5%E L7232 & 2 fELE L £
R

(7> =ay) ZO EtherChannel (Z VLAN 7 A4 ¥ —T7 = f AEFHELET, ZOFIED

B O, P =T oA ATHA S NET,

(FVF ar7HZX L E—F) ZOFHZTETTLHRIC, 2 TFAMA I =T AR

ZEID Y THLERDY £,

a) [OK]%Z7 Vv 7 LTEFTNEZMELET,

by A1 F—T A A%EEIDYTET,

) T—WNRHRETLaLTFAMEEFELET, [DeviceLList] XA > T, 77T 47725
AADIPT RLADTFIZHLAVTHANGEL TNV v 7 LET,

d) [Configuration] > [Device Setup] > [Interface Settings] > [Interfaces] <A > Z TR L, WA F~
ARXFTHR—=RNTF XY RN A F—Tx A AZRIRNLT, [Edit] 27 Vv 27 LET,

[Edit Interface] ¥ A 72 7Ry 7 ARFRINE T,

[Generall| # 7% 7V v 7 LET,

(FZ2AXT LY b E— 1K) [Bridge Group] e v 77X JA ML, ZOAf X —T =
AAEEOLTCHTY vV FN—TER LT,

[Interface Name] 7 4 —/L RIZ, 4% 48 SLFUNTATI L ET,

[Security level] 7 4 —/L RIZ, 0 (F&IK) ~ 100 () OV~ a AT LET,

(—7 v RE—NK) IPv4 7 R L RIZ%F LT [Use StaticIP] A7 va v K& %7 Y v L,
IPBIXO~AZ%ZAS)LET, DHCP & PPPoE [V HR—hSnFEthA, HA L MY —KA
MEGEOS S, 31y ROV TRy h v A7 (255.255.255.254) ZIBETEET, ZOHE.
Fy NT—Z F70137 08— FXFx AN 7 RLAHADOIP T FLRAI PR ENEEA, FTF R
A7 UL v b EF— FOBEIE. EtherChannel f v X — 7 = A A TliI, 7V 7 —7 4
VHA—=T A ADIPT RLAZRELET,

=7 RE—NR) IPv6 7 RV RAERRET DHITIE, [IPV6] ¥ 7457 U v 7 LET,

KZ 2T Lk B— ROEAIE. EtherChannel £ % —7 = A ZATiER, 7Y w2 F
N—T A B =T ADIPT RLAEZRELET,

a) [Enable IPv6] F = v 7 Ry 7 A% AN LET,

b) [Interface IPv6 Addresses] =V 7 C, [Add]| &2 U v 27 LET,

[Add IPv6 Address for Interface] 1 7 1 7R v 7 ANKRINET,
(G¥)  [Enable address autoconfiguration] 47> = YA — b I EHA,

c) [Address/Prefix Length] 7 4 —/L RIZ, 72— L IPv6 7 RL AL IPV6 V7 4 v 7 AD
FEEZANLET, 72& 21, 2001:DB8::BA98:0:3210/64,

d FFvay) AAKNT RLAELTModified EUL-64 1 > % —7 = A A ID &3 512
X, [EUL-64) F= v 7Ry 7 A d N LET, ZO%A L, HIZ [Address/Prefix Length]
TA4—=NVRIZT VT 4 7 REANTTLET,

e) [OK]Z7 VU v2r LET,
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ATv 14
ATy 715

ASA 2 5 22 DRI ASA 4 5 2 4 ~0sm [

[OK] #7 U w2 L, [Interfaces] MiAEIIZFRE Y F7,
[Applyl 27 U v 7 LET,

ASA U SR ZDIERFTZIZASA U S X Z DS

I TAZNDKZ L=y FIRT TAZIISBMT HI2E, 77— ATy arry e Fal—s

:/Z)S‘le‘g‘(:\‘g—o

=SARAEDY 4 ¥ — FDEIT

Y

I FALZRNDK L=y NI FTAZIIBMT HITIE, 7= ATy T ar7sFalb—va
YRMETT, 1BEO2=y b (¥vAX—2=v MMI7%) | THighAvailabilityand Scalability
VAP—REFETLTIZ TAZEER L, W TAL—7 2=y h&BIMLET,

G¥)

v ARZ— =y MIX LT, cLACPVATADBIARTIAFTVT 4 DF 7+ /L NEEHT
DHAE, VA= E2EATEERA, T AXEZFH CTRTCTIDLENDD £9,

188 BRI

e NTF arTHFANE—RTHE, VAT LFETAXN—ATROFIEEZFETLET, 2
VAT A AT 4FXalb—vary E— RIASTWRWES, [Configuration] > [Device
List] XA > T, 77T 4 TIRTNNAADIPT RLAD FIZH D [System]| Z X TNT V) v
7 LET,

« 7 ZALHIEY 7 DMTU % 1600 34 ML EICRRETHZ AR LET, 20X HIT
T2, ZOFEEFHITIENE L=y P T VR T L —2DOFEA X —TMIT
AVERNHVET, Pr AR 7L —LDOFRINTIL, ASA DU r— RRLKETT,

U TAZMHY T A E =T 2 f ANMET DA F—T = A AL, B SNTCAA v
FTT v TR /2> TV D UENRD Y £T,

BT D T AXIZa =y NEBMT D &, —FRIC, RENRS7 > MER Ka v 7
DEATHZERNHYET, ZNITTEEBY OEETT,

FIE

AT 71 [Wizards] > [High Availability and Scalability Wizard] DJEIZER L £7, ROFIETZ DT 4

P—=ROHTA RTA MR LTI IZIN,

AT 72 [Interfaces] Hi[fi > 5 13 L V> EtherChannel Z{Ef T £HA (7 7 AXHIHY 7 Z25x<)
AT w73 [ASA Cluster Configuration] Hi[fi C, 7 — hA NT v 7 OFREEHEK L T,
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* [Member Priority] : ¥ A% —a2=v MEEMIC, ZO2=y DT FAF VT 1% 1~100
DOFRFATRELET, | D@D TIA AV T 4 TT,

« (Jb—FT v K E—F., R/t F EtherChannel E— K) [Site Index] : %1 hE 7 T 2 Z Y
YIEEHLTHDSSSE, Z0ox=y hO¥A FID (1~8) ZREL., A MNEAD
MAC 7 FLABMEH SN D L HICLET,

« (A7 =3 ) [SharedKey] : 7 7 AZHIHY > 7 DFIE ~ T 7 1w 7 DW= F—Z &K IE

LEd, HEMEIL 1~ 63 XFD ASCH XFHTY, LAMEIL, e x—24ERT
LHledIEHINET, ZORTA=RT, T—HNRNA NTT v T (BERRET v
T— ML IND Ny h R E) ITEEEBLERA, T—F XA NT T 4w 71E, HIT
VT THXRANE LTERFREINET, AT — RORSL—ER %A RX—T NI T DY
BIZb, ZORTA—FERETLHLERH Y 7,

(A7 2 ) [Enable connection rebalancing for TCP traffic across all the ASAs in the cluster] :

O A A X —T M LET, ZORTA=ZIT 74V N TET 4 8—T I
BRoTWET, £ F—TADOEAIE, 77 AZO ASA ITEMICARERE LI L, &
DD TND T /8 ZANBARDDIRNT A R LRz 47— FLET,
AR ST DR Z . 1~ 360 BOFHNTIREL £, TONTA—=ZF, 7—
FARNT T a7 4F2b—varO—HTIER, SAX— 2=y FPbAL—T
o=y MIERENET,

GE) oA M M AR IS LTI BRI OH B EBE L2 T Z S, Beb ¥ A
NDY T AL A NF R O BTE £ A,

(A7 =2 ) [Enable health monitoring of this device within the cluster] : 7 7 A ¥ = |
NVAF =y JHEREE AN LE T, 2=y FONVAZHERT D720, ASADY T 242
2=y MIZZAZHI#Y 7 T2 =y MNIN—FE— M AvE—VEFELET,
2=y PARERREINICE Y 2=y hvbv— FE— kN A v bB—UVZ%E LRWGATR
ZOET 2=y MILBERRELITT v FREL RS ET,

GE) oD R PERETIEE (2, T A F—T oA ADBME
T2IEHI. ASAETZIEAA v F LA v 2 —T 2 A ZADA X —T MbEITT +
t—7 Uk, VSS E72IXVPCETERT H AL v FOEMARE) 1L, ~NVATF =y
I EF 4 —T ML, TA =TI LA v B —T oA ZADE=Z Y T
TA®—TNZTHRLERHY ET, PARTVOEFENETLT, 27 %=
L= VEERTRTO2=y MRS, ~NVA Fx v 7 Z2HEA
F—T M LET,

* [Time to Wait Before Device Considered Failed] : ~ DfElX, ==v "OXF—TT 74 7
AT —=HA Ay E—VOMBERELET, 03 ~45BTT, 7744 MI3PHT
D

« (A7 =3 ) [Broadcast keepalive messages to all EtherChannel cluster control link ports
for VSS/VPC support] : 77 7 A X {filffll Y > 7 73 EtherChannel & L CE%E I TWT (i
$E) | VSS E72iE vPC XTICHER SN TV AHEIE, 204 T va vk x—T 0
(2T D ZEDRELRDGENH Y £, —HO AL v F T, VSSWPCD 1 DD
=y "MV Y Y MU UCEITEET D L ED AL v FITEEHE S ALz EtherChannel
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samtoy - roxs ||

AUN—= A H =T 2 A AP ASAIZH L TT v 7IRETHD LR AETN, 2
NoOA L E—T 2 A AFIAA v TFRONT 7 4 v 7 2B L TWERA, ASAholdtime
timeout Z KV ME (0.8 Fb72 &) IZRRE L7126, ASANIRS T2 7 AZ M LHIBRS 1
DAEREMENH Y . ASAIINN—FE— K X v EB—T% 2105 DV T 02D EtherChannel
AVE =T oA ATKEELET, ZOF T a a2 X—7NICTDHE, ASAIZV T
2D > 7 O3 _TCOEtherChannel f > % —7 = A AT/HN—FE— kK X vE—
753 9F 40T LT, DR EBIBDAAL v TFNENEZIETEH L E2MERL
7,

« (F 7T = ) [Replicate console output to the master’s console] : AL —7 L= K5~ R

g—a=y h~Daryy —EGR-EA =TV LET, ZOKRRILT 7 40 hTEZIZ

RESNTWET, ASAIL., BEDERA NV MRRELEZLEXIC, Avb—VahEED

Y= NMIHATOHEERH Y £, ar Y =W\ Rle A X—=T T HE AL—T 2

=y MBI AZ— A=y MZaryY— L Ay E—URFEESNDLDT, TE=FNNE

WZRDHDITI TALZDAY ) —)VR— RN DEFERVEST, ZONTA—=FF, 7—F

AT a7 4 Fal—arO—ETIIRL, A —a2=y b HAL—T 2
=y MIERENET,

* [Cluster Control Link] : 7 7 AZMlfH ) > 7 4 2 —T = A AZtEELET,

(A7 ay) [MTU]: 7 ZAZHN) 7 A v B—T = A 2D KRIGIEHNLZ 1400
~9198 XA FOFEPANTIRELET, MTUME LY b REWTF—X X, H#ERICT 7
A MEERET, T 74/ FOMTUIL1500/%4 R T, TV YR 7 L—
LDTHKIZA F—T M L THDHEEIE. MTU % 1600 XA FARICRETHZ &L %
HIRRLET, Vv R 7L —252HTILERDHY, ELEVY AR 7L—ADT
KA RX—T ML TWRWEAIE, V4P —FRE/&TL, Yy AR 7L—L0%A
F—=TMZLTh L, ZOFIEEZFHHTLILERH Y 7,

AT 7 4 [Interfaces for Health Monitoring] Hi{fi T, —#DA v ¥ —7 = 4 AZEEDET=F U o 7 %4
BEANCEET, Tl T BEA X —T oA Rp L MHUSNDA F—T =4 AD~)L
AF=H YT T 4 B—T T BT ENTEET, ASA Firepower £ = — /L7 EDoN—
R =27 BV a—NEE=2Y TR0 bRV 5121, [Exempt Service Module from Cluster
health monitoring] = v 7 R > 7 A& A 1 LET,

GE)

fAILNO MR VEREITI L& (2, T—F A F—T =4 ADBMEIF
B, ASAZE7213AA v F LA v B —T =2 ZADA F—TNMLEIZT o B—T L
{b. VSS E/IIVPCEIELT D AA v FOBMRE) 1F, ~"NAF 2y I %T 41—
TV, TAB=TNMZILIEA =T 2 A ADE=HX ) T HT 4 =TT
LHUENRHYET, MR YOERENRET LT, a7 4 Falb—a VEERRTR
ThOa=y MR ENTES, ~NA F v 7 ZEHEARX—T I LET,

AT w 75 [Interface Auto Rejoin settings] [H[Hi T, A VX —7 = A AE721X 7 T A > 7 TREENF
ELESAEOBEBEREEREEIAL~A A LET, XA 7L, ROA TV a2ZRET

SET

+ [Maximum Rejoin Attempts] : 27 7 A ¥ ~DHFFEG OFITEEZ EFHZT 572912, [Unlimited]
F721X 0~ 65535 DHIFATHARELE T, 0IXZABHFHEEEZT A E—7 VT LET, 7
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TV MEIE, 7 TAE A B —T =2 A ADOEAT [Unlimited], ¥—4% A >4 —7 = A
ADEFAEIE 3 T,

* [Rejoin Interval] : A ATHBOREZ EFRT D722, 2 ~ 60 OFIPH CHIREA X E L
F9, T7ANVMEIZSHTT, 7 T7AX~OFESGE L=y NBRITT DR KGR
(X, BtEORMDN S 14,400 S3IZBRHTWET,

* [Interval Variation] : 1 ~ 3 O#i THREL T, HRZEMESELNEINEERLET
(1:EERL, 2: HATORRO 265, 3 : EATOMRD 3 £5) . 72& 2%, MRE 55
WCRRE L, 0% 2 ICRE LTS EIE, RPORAITN 5 5%, 2 BIHOFRITH 10 ot (2
x5) . 3IBEEORITA200% 2x10) &7V ET, TTANMEX, FTAXA UK —
T2 ADBEHRITL, T—EA L H—T oA ZADEAHIT2 TT,

ATw 6 [Finish) 27 V27 LET,

ATFYTT] ASAIZEfTI L 74 X2l —2ar A% LT, ZTAX Y 71Tk LTV ERED
HHfa~ ROFWRAEFHRET, 7740 har 7o Falb—vailbdbavr Ry, 2
MICEES TN £, Ao na~<y REHIBRT5ICX[0K] 227 U v 7 LET,
[Cancell] 7 U v 7§D L, 7 TAZ Y U TIF3A FX—T NIl £/ A,

LIEHLTDHE, ASDMMNY T AX A F—T /T L TASAIZHHER L, ASANRNY T AKX
BINE iz Z & 2R 9 % [Information] B 23 F R SV E T,

GF) AT, V4P —FRORETHRIZZ TAZIZSIM LTI T —BRETH A
REMENH Y £7, ASDM BUIKF ST\ 5 & ASDM IXZE1THi< =7 —% ASA >
LEZELERA, ASDMICEER LB G TAX D U ITRT 12— V%A,
ASA a1 Y — )L R— NI LT, 7 T AX ) I RNT 4 —T > TV DRk
MR T — RS BRBERHY FT, 2T, 77 AZH@EY o Rng T
LTCWH AR H Y £7,

ATY T8 AL —7 2=y FNEBMT DI, [Yes] 227 Vv LET,

VABE =BT 4 P— REBRIATT L5, V1 P— FEREMNCHLT 5 & 12 [Add another
member to the cluster] 47> a VA BINL TR L —7 2=y FEBINTEET,

AT 79 [Deployment Options] i1 T, ¥k ® [Deploy By] 4 7Y a2 DWWz iR L9,

* [Sending CLI commands to the remote unitnow] : 77— h A N J7 v 7 a7 4 Fal— g v
EAL—T7 (—F) FHIPT FLACHELES, AL—T7HHIP 7 FL A, 22—
b, NAT—REATTLET,

+ [Copying generated CLI commands to paste on the remote unit manually] : A L —>7 ==+ b D
CLITa~Y Rzl y b7y R_N—=AK FLFTASDM O CLI Y — /v Z2fi 45X 512
o~ R&EAERR L ET, [Commands to Deploy] R 7 AT, % CTHHATLZHDDa~v R
ZERLTa—LET,

. ASAY S R4
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Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet(/4
no shutdown
cluster group clusterl
local-unit asall
priarity 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test

enable as-slave noconfirm

DIRBVITEHEDHAREZTAX

PITGARY T VA ET=R Y T TCP G EMOBIE, 7a—0EE ) T 1, MORKE
b AR~ A X TEET,

VAH— 2=y NTIROFIEEFITLET,

ASA U S R B DEKXRING A —F DERTE

VAF— 2=y NEDT TAIBREENAZ A ATEET, 7 TAX~D=y FDBI
W4 P —=FREHEHLRNERIE, 7 T7AX NI A—FEFETRETEET, T TIZTA
BV TNAF—=T N THIUL, W ODDT FTAZNRTA—ZERETEET, 7 I7AFY
VIMA X =TI TV D MIEIRETE WL O, v/ ErahEd, ZoTIEIC
. VA= FRICEENTOWRWVWEERRTA—2EENET,

1R BHHIIZ

o 7T AZIBINT HENT, KL=y T IFAXGIHY > 7 L 2 —T = 4 A HFNIE
ELET, VoI NAE—T oA ADGE, A X—T VT HHERHY £3, MO
TE 2R L722n T < 72 &V, EtherChannel f > % — 7 = A ADYAIL, A F—7 ML T,
EtherChannel € — R & 4 IR E L F9,

e vNTF ATXANE—RTE, vAF— 2=y N EOV AT AFTARX—=ZATROF
EZEITLET, FHEVAT L a7 4 Fal—T a3y T— RIZA>TORNEA,
[Configuration] > [Device List] XA > C, 7277 4 77T XA ADIPT RLADFIZHD
[System] Z X 727V v 7 LET,

FIE

AT w71 [Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] ?JI&
WBIRL £,
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T FRZZT A APBMENTEY, ZANRTAZ—a=y FOLEIT, 2O
IZ [Cluster Configuration] % 7125 VW £97,

AT w72 [Configure ASA cluster settings] = v 7 R v 7 A% AN LET,

Frxv IRy I AT 7D, REMHESNET, "I A—FORENTXTETTSH
F C. [Participate in ASA cluster] 4 2 L7722V TL 7280,

G U7 I7AZV T %A F—T M LT, [Configure ASA cluster settings] 7 = v 7 7R v
I AEA 7T %A1, MRELSHEMM LD A TIToTLLES VY, A 72T 5
ELTRTCOITAZ a7 4 Falb—varyBs U7 S, ASDM D38kt ST
WHEBA L H =T 2 A RAEFLTXRTDA =Tz A AT ¥ v hF T LE
T, ZOHE, BERcETT A0, 2V — /LR —KFTCLIIZT 78R T HMHE
N ET,

ATYT3 MOT = AT T RTA=HERZELET,

* [Cluster Name] : 7 7 A Z\ZAHTZATT £ 40T 1~ 38 3050 ASCIL L FHITH D =
EMMETT, JIAXIZZ=y OV 1IOLDPRETCEETA, FTAXDTRTO
AUANE CARTEERT H20ENH Y £,

* [Member Name] : D7 T AZ A \DEADAHITZ 1~ 38 LF0D ASCI LT THEIE
LET,

s [Member Priority] : v A ¥ — 2= MEEHIZ, ZO2=y "ODTF7A4F VT 1% 1~100
OFFNTRELE T, | BIREOTTA AV T 1 T,

o [Site Index] : ¥4 NEZ ZAX VU T HEHLTWHEE, Z02=y hOY¥ A FID (1
~8) HRTEL. YA FMEADMACT FLANMERHEND Lo LET,

o (X7t = ) [SitePeriodic GARP] : ASA Ti, Gratuitous ARP (GARP) /3% k&AL
LCAL Yy F U T AT TARNT I F v ICRHOREIZHELE T, &V A OELIR
PAER R B RN A R -2T, 72—V MAC/APT RLADGARP N7 7 4 v 7 INE
ARSI ET, £ A3 K EtherChannel D= k& %4 N MACEXOIPT R
LAZLIZY A FIDZRETHE. GARP X T 7 4/ b THEIZZ Y £9, GARP [HlF
Z 1~ 1000000 FIIZHELET, 7 74+ /b MME 290 B TT,

I TABMMBEEENTZTA PTEOMACKEIIPT LA Ly b3 A FEAD
MACT RLABIIPT RLAZMHT DKL, 7 T AX TG L=/ v ME,
71—V MAC T RLABIORIP 7 FLAZEHALET, T 74 v 72BN 7 a—3L
MAC 7 R LA EBIZAER S L2 WEE, 72 —S)LMAC T RLADAA v F T
MACT RLVADEA LT U MRBETLAREENH Y £T, XA LT 7 MRIZZ m—
IWMACT RVASND NTZ T4 INAA T T AT TANT I F X 2RITDIZY 7
TT AT EN, ZHICEDAR T 3 —< ABLO XY T 4 FOENREAETSHZ
ERH FET,

o (X7 a ) [SharedKey]: 7 7 AZHIHY > 7 ORI T 7 1 v 7 DM F —Z 5 E
LET, HEMEIL, 1 ~ 63 XFD ASCH XFH|TY, ILAMEIL, e —24ERT
LHIDIERHINET, ZONRTFA=FE, T—HRA NTT7 4y 7 (HERET v~
T— FREEIND Xy M E) ICIFREBLEYA, T2 T 74 v 71%, EIT
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7UT FHRAPLLTEESNET, "R — ROBBLY —E2AEA X—T T B85
BIEH, ZORTA—FERETHUERD D ET,

s (AL = ) [Enable connection rebalancing for TCP traffic across all the ASAs in the cluster] :
B OBES A A R —T NI LE T, ZONRTA—FIIT 7 H/L NTIET 4 B—T I
BRoTWET, A F—7LOBFAIE. 7T AXD ASA ITEMAICAmIERELH L, A
DD TND T A ANBAFDODIRNT A AT LW EEta 47— FLET,
AMERE T SRR Z . 1~ 360 POFHANTIREL T, ZONTA=XiF, 7—
MARNT T a7 4Fa2ab—v g O—8TER, vAX—a2=y kB AL—T
o=y MBI ET,

+ (AL =3 ) [Enable health monitoring of this device within the cluster] : 7 7 A% == k
DA F =y 7HEREZAMCL T, 2=y b —FE—=F AT —=F X Ay E—HO
REfEIfR AR E L E T, 03 0D 45O TERTEET, 774V MI3HTT, F:
Frlna=y &7 7 AXTBIMLTHNT, ASAEIEAAL v FO MR YRNERIND
Yitr. 7 7 ALPGERT HETIOMREEL —RIIZT 4 E—T ML, T4 E—TMIZE
NEA =T 2 ZADA LB =T 2 A ZAE=Z VT HT 4 B—T T DHHLERD
%9 ([Configuration] > [Device Management] > [High Availability and Scalability] > [ASA
Cluster] > [Cluster Interface Health Monitoring]) ., 7 7 A X & FARB VUOEENET LT-
O, ZOWEZHEAR—TNMITHIENTEET, 2=y hO~NVRAEMHRT HT-
W, ASADY TAL =y MIIZ T AZHEY 7 ToOa=y MIN—FE—F A v
t—UEEELET, 2=y FPIREFRINICETY 2=y M b —FE—F A vE—
VEZEFELRWGESIEL, FOET 2=y MIUSBEREEZILT v MREL R sivE T,

« (A7 =3 ) [Broadcast keepalive messages to all EtherChannel cluster control link ports

for VSS/VPC support] : 7 7 A X itV > 7 73 EtherChannel & L Ca%E I TWT (i
$F) | VSS 2L VPC NTICHERE SN TV DAL, 24T va ik A x—T L
(2D ZENREIIRDGBENRDHY £, —HDAA »F TiE, VSSWVPCH1-DOD
=y "B Yy MU UCEIFEET A &, FD AL v FITHEHE S 4172 EtherChannel
AUN—= A B =T 2 A AN ASAIZK LTCT v 7IREETHDH LI ETN, 2
NoEDA L F =T 2 A IR v TFRD T 7 4 v 7 2B LT ERE A, ASAholdtime
timeout Z {K\ Vi (0.8 Fb72 &) IR E L7284, ASADNIR- T/ 7 A X IMLHIBRE L
LHAREMEDN D D . ASAIFN— FE— F A v E—T% 26DV T§17 EtherChannel
AVE =T A RAZERELET, ZOFTvarkAx—TNMITDHE, ASAILY 7
ZZHIFY > 7 DT T O EtherChannel f > % —7 = A A T/N—hE— K A v E—
77T 4T LT, Pl LB I BDAL v T RENEZETEDLZ L 2MHERL
£75

« (A7 3 ) [Debounce Time] : ASA XA X —7 = A AZEENFELTND & R
L., 77AZ0hba=y FPHIBRESNDETOT AT ARMZRELET, T OEEIC
IV, A2 =T AOEEEZ LV RRIRTEET, TV ARREZEL T
L. BRHOFEEMENRELS R I EICER LT EE N, /1 F—T 2 ADAT—H A
HHNFETDHE, ASAITA U F—T oA AZEHEL LTy —2 L, ZT7AENPDH=Y
FNHIBRT A ETIRESNT I VRS L 9, ¥ U RENSBEMREBIZEBITL T
% EtherChannel D55 (A4 v F NV v— REN7z, ERIEAAL v TFREDI/R->TND
EtherChannel 72 &) | 7137 VAR Z R T56Z LT, oy T A% 2=y hOFHR
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R=FDONRU RARENEWSIFHHBIZIT T, 79 AZ 2=y h FTA v Z—T = A ART
T—RRENDIOEBESZENTEET, T 74/ bDOFT T AL 500 ms T, A
N7E DO IX 300 ms ~ 9 BT,

(472 a ) [Replicate console output to the master’s console] : AL —7 = kN H~v A

-y boDayy =G E A X—=T M LET, ZOKRRIZT 74/ TEYIC
RESNTWET, ASAIL, HEOERA RV PRBELILLEIZ, AvE—VEEED
VY= MIMNTDEER L £, ar Y A EREN X—T T L, AL—T 2
=y b vRE— 2=y MIary Y — L Ay e—URNEEINDLDT, TE=FPNE
ZRDDIEI TR DAY=V R— M DEFERDET, ZONTA—=2F T—h
ARNTGy T ar74Xalb—rarO—HTER, vAX— 2=y FPHLAL—T =2
=y MZEHENET,

(A7vay) 953R2)05 20—FEYF 454 2—TIIZLET, LISP A A2
7alORE (10X—=) 2B LT EEN,

(47> 3 ) [Enable Director Localization for inter-DC cluster] : 7 — 4% &7 L % —®DH A k

M7 A2V T TNT =< A% EIFTT U R R v TR OBRIE 2 FiE T 5
Wi, Ta vz 2= B—va a2 X—7MILET, BE. B LWERITe—F
NTUASINT, FEOYA MNO T TALZ AN—=IZLVPFrESNET, 72720, ASA
T4 LI ZOKREZAEEDYA D TAUNAR—ZEHV S TES, ToLr7¥n—h)¥—
Ta IR BMOT 4 V7 ZEEINA X =T IR £, 2L, FrAE ERCY
A MAFET DR =N T4 LI E e AEEOYA MIRETEL 70—V T 4 L7
2T, fIEELET AV 2R UYA MIRETAHZET, X7 r—< ANMELE
T o, TOFABETHEENEELLGSG, v—A T 10 L7 2%, RUYA R THL
WEERFITAE B A BIRLET, 7 T AX AU N=RHOH A N THA ST DD N
ey NEZETAESIE. /a— L F o L7 ZANMERESNET,

(# 7' a ) [Site Redundancy] : A FOEENG 70 —%R#ET 57212, 14 bD

TLEWZAENNCTEET, BNy 7 7 v 7 A —F =04 —F—LR TV A MNZHDIEH
X, A FNORBEENS 7 a—%R#ET 572012, BIMONY 7T v 7 F—F =R A
MPLEBEBREINET, T4 V27 ¥ u—R)E—Ta & A bOREMITR A« OMEET
To ZOIHDO N DELITIMFTERETHIENTEET,

[Cluster Control Link] : 27 7 ALY > 7 4 v 4 —T = A AZRELET, ZOA 25—
7= A A, RESNTOLAREMATE A, BAERRAS VY =T =g ZANF
oy FET YR MIFERENET,

o [Interface] : A > % —7 =4 AID, T& NI EtherChannel Z##5 € L ¥4, V7oA  F—
T2 ARAEEHEANT A X —T oA AFHFATINEEA,

« [IPAddress] : IP7 RL Z|ZIXIPvA T RL AZ$EELET, IPv6iL,. DA 4 —T =
A ATV FR—FSNERA,

* [Subnet Mask] : &7 % v b v A7 ZEELE T,

s (AFTay) [MTU]: Z ZALZEHNY 0 A4 2 —T = A AD I RIBEHALZ 1400
~9198 A FNOFHHENTHEELEYT, MTUMBL Y b REWF—Z13. HEFNCT T
TA v MEERET, T 74/ OMTUIZ 1500 234 kTF, MTU % 1600 /XA kLA
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1v8—7x42D~LR =8y v psvanERsonE

FICRETZ 2L EHIBLET, 20T BI0E,. Vv R I L—bDTHRIEA
X =TT HRERNH D £,

« (A7 =3 ) [Cluster LACP] : A3 K EtherChannel % fl4- % & &%, ASA X cLACP
AL TRA 3= A A v F & DM TEtherChannel D% F > —> 3 %47V Ed, cLACP
FALT— g VORI, RILZ 7 AFND ASA IZEWIZEHET 2720, A4 v FITIE
120 (KAR) THRAATHLINOEIICRZET,

* [Enable static portpriority] : LACP DX A 7 v 7 R— N FIF3AF VT 42T 4 &—7
MZLET, —HBOAAL v FIIFXATIv I F—bF T I7A4F VT %2 R—FLT
WRWD T, ZONRTA—=FIZLY AL v TFOREENRM ELET, 612, 8L
W% DT 7T 4 772 A% K EtherChannel A > /XD YR — MR A x—T L0 F
T (K32 AN) , ZONRTGA=ZEBMEHLRNE, FAR—FENLDIE8ED
TIT 4T ANRESBEDRAIR N A NROBTT, TONRT A=A F—T
MM LTEGE, AZ R, AN TEERA, TRXTCORAUANRT 77 47T
To ZONRTA=FE, 7= ATy T ar74Fal—arO—HTIER<,
YA — 2=y MpbAL—7 2=y MIERINET,

[Virtual System MAC Address] : MAC 7 R L AJBEXTH 5 cLACP ¥ A7 A ID &% i
LET, TRXTCOASANF LY ATAID ZFEHLET, ZHiE~AZ— 2= |
R THBAERSN (F7x0 ) | TRXRTOED XY 2=y MIERIE
To HBOWVITHHHDOEXTFH TRET S22 TEET, HiIZl6 By hd 161
¥cd, =& z21E. MAC 7 R L 2 00-0C-F1-42-4C-DE I%. 000C.F142.4CDE & AJj L
FI, TORIFA—HFE, T—F A Ty T ar74Xalb— g rO—HTILAR
A, A — 2=y "B ALV—T o=y MERISRES, 72770, ZofEi.
TIGARY T RN LG RICDRERCTEET,

[System Priority] : 1 ~ 65535 OFIFACI AT A T ITAF VT A 2HTELET, 774
V7 FERREEZHEY T 22 =y FOWEICHERSNET, T 740 F T,
ASAZTT7AFVT 4 1 EDTITAAVT 1) ZEHLEST, ZOFF7A44Y
TANE, AAYTFOTIFAF VT4 LR ENVETT, TO/NT A —FX,
T—RANTFI T ar 74 Xal—varO—{HTER, vAX— 2=y FpbH
Ab—T o=y MIERINET, L, ZOIE, 7 I7AX ) 7RI L
A OHRERTEET,

AT 74 [Participate in ASA cluster] = v 7 Ry 7 A% AN L T, 7 7AXIZBIMLET,
ATy TS5 [Applyl 27 U v 7 LET,

AVB—TITARADANIVRAEZR) VT BLVBESEREDERE

T X, WA =T oA AL WAUSNDA VB =T 2 A ZADNVAE=LZ ) T %
FUE—TNMITEHZERNTEET, EEDKR— b Fy xVID, JLEID, H—0WH 1
H—7 A AID, F£72ILASAFirepower £V 2 — N7 EDY 7 N =T /INN— R =27 TV a—
NEET=HTEET, ~NVAET=HY TIEVLAN YT A o H—T 2 A, F£7201X VNI X°
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B sz 120 0z 228 vrBrvEDBREADRE

ATy T

ATvT2

ATvT3

ATvT4

BVIZR EDOEHAEA X —T 2 A ATIHEITINERA, 7 T7AXFIBY 7 0e=421 70X
RETEXEHA, 2OV ZIEFICE=ZEINTWVET,

FIE

[Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] >
[Cluster Interface Health Monitoring] O JIE|Z 8 L £ 97,

[Monitored Interfaces] 7N v 7 A CA L Z —7 = A A% EIR L, [Add] %~ Y v 7 LT [Unmonitored
Interfaces] R 7 ANZEDA L —T = A A=BENLET,

A B =T 2 ARAT—=H A A vE—VICLoT, Vo 7EEMBENET, FEDOmEE
A B =T A ADTXTOYHER— IR, FFEO2=> b ETIHEEENBAE LD, Mo
=y N EORUGwHREA V=T 2 A ATT 7T 47 HR— DB L5E, D=y MIZ T A
ANHHIBRENET, 2=y POF—/L RIS v F —T 2 A AT —H A A yb—3
B LW AIZ, ASADRA U NG T AZNLHEIRT H5FE TORMIX, A1 ¥—T7 =1 A
DHEAT L, FDL=y NINFENLEA AL NTHDIMN, FRT7 T AXIIESMLES E LTV
DMK -oTERVET, TN TR, ~NAF 2o 73T _XTDAS  H—T = ATA
=T NI TWET,

T2, BEHA L —T oA A Y WAUSNDA VB —T 2 A ZADNVAE=HZ Y T %
TAR—TNITHZENTEET, A= FF ¥V ID ETNEID, £2THE—-OYHE A
=T 2 A ADEHBETCEET, ~"NAE=HFIY TIEIVLANY T A 2 —T A A £z
IZ VNI °BVI 2 EDRAEA ¥ —T = ATRHFETINERA, 7 TAFXGIY) > 7 DE=
Y UTIIBRETCEEFRAL, TV U7 ITEICE=X I NTWVET,

fAISHO hARrVER (ZE2ET7—F% A ¥ —7 = A AOBNVEIER, ASA 72T AA v F
LA B —T =2 ZAOHF/EEEN, VSS £T21T VvPC ZEKT DAL v T OB E1TH
EETIE, VA F oy 7 BEREE #5312 L ([Configuration] > [Device Management] > [High
Availability and Scalability] > [ASA Cluster]) . b L7-A > X —T =2 ADE=X VT
FEMZ LTS, MRYOEERET LT, 274 Xalb—Ya VEERTRTO=2
=y MZR#IENTE, ~NA F =y VTHERBEFEA X—7 W TEET,

({£E) ASAFirePOWER EY 2 — LR XON— R 2T EHZ /7 N0 =27 B a— L&
b9 % 121X, [Exempt Service Module from Cluster Health Monitoring] F = v 7 7N > 7 A % A /1T
LET,

ASA 5585-X Tlt, —bEREV2a—NDEFE=X ) T E2ENIT D54, flice=%3h
BEVa— N EORA LB —T 2 ADF=R ) U TR EHCTHI L TXET,

AVBE—=T oA A, VAT A, T TAZEEY 7 ITEENEAE LTS E O HEIFRES
DEEE N AR~ A AT DHITIE, [AutoRejoin]| ¥ 7527 VU v 7 LET, K54 72 L T[Edit]
70 vl LTCROBREEITWVET,

* [Maximum Rejoin Attempts] : 27 7 A Z ~D GG OFATHE 2 EFK T 5 72DIZ, [Unlimited]

FE7212 0~ 65535 OHFPACTEZRELET, 0ITHBHFESELT -7 M LET, 7
TANVMEIX. VT AE A E—T 2 A ADBAE [Unlimited], T—% A > X —7 = A
2B IVY AT AOBEIE[3] T,

. ASAY S R4
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525 P noEEnEE [

* [Rejoin Interval] : FR5ARITRIMBORR 2 €K T 572012, 2 ~ 60 OFPH CHIREZHTE L
F3., TIHNLMEIZS DT, 7 I AZ~OFEG =y FRRITT S RRE IR
1. BB DRI D 14,400 IR S TUWET,

* [Interval Variation] : 1 ~ 3 O#i THREL T, HRZEMESELNEINEERLET
(M EHRL, 2: EATOMKEO 2 5, 3 B0 3 f5) . 72L& 23, HEZ 559
ICRRE L. Bord 2 \ICRE LI ald, RYIORAITHN 553t 2 M HORIT 10 0% (2
x5) . 3MEEORITN205% (2x10) L7V ET, T T AN MEIX, FTAX A X —
T2 A ADBHRIE[N], T—HF A v 2 —T 2 ABL RV AT LAOHFAIL[2] TT,

T 7 )V PR EIZRTIZIE, [Restore Defaults] 27 U v 7 L7,

ATv TS5 [Applyl 27 Vv 27 LET,

75 A% TCP BHEDELZDELTE

ATy T

TCP i D 7 7 A BMDBIEZ G LT, T4 VI XNy 7T v 7 7a—{EROBIEIC
AT E N7 o —CBE T 5 [RERIEE) PR CTEXET, T LI /NI T v
77 u—NMERENDRENCE =y FAKET A5/, TAoDT7u—%EETHZ LT
FHA, RIS, 78 —%2ERT2R1IIC N T 7 4 v 7 BBlO =y MNIHHE NI LS. it
NEBEETDHZ LI TEEEA, TCPOT U F MuETNMET 25 8T 7 4 v 7 O TCP DR
DIIEZFIE LRV E T DRERH Y £,

FIE

[Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster
Replication] DJIEIZIRIN L F 5,

ATv T2 [Add] 27V v 7 LTRDIEZREL 7,

* [Replication delay] : 1 ~ 15 O#iH THEZHE L 7,

«[HTTP] : $XTOHTTP 7 7 1 v 7 OEIEZBE L ¥, Firepower4100/9300 > ¥ —
DI, ZORFETT 7+ /v M TS THEIMEES N THET,

* [Source Criteria]
*[Source] : IHETLIP 7 RL AZRELET,
*[Service] : (A7 vrar) HFMEIHAR—FERELET, BT, BEICEITSIER—
ROWTNINEBRET D70, WT & BIZERE L £ A,
+ [Destination Criterial
* [Source] : B IP 7 KL A &R EL 7,

e [Service] : (A 7T av) FEAeER—FERELET, @FIL, FEILEITFIER—
FOWTNNERET D0 W& BITHRELEE A,

ASAY S R4 .
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B v ressons

ATy T3 [OK]Z27 V7 LET,
ATy T4 [Applyl 227 U v/ LET,

YA FEKEEDRTE

P4 M2 TR YL OB, TTEEE REREEDH0IC, REEDAF v A ATEE
T,

S5 72— FEEYTFLDETE

LISPO NI 74 v 7 #REBELT, =084 Nl 2BET 07— T 4 2H%)
IZTEET,

LISP A 2 AT 23 DT
LISP "7 7 4 v 7 2B ETHILET, VA FMEOZ7o—DEE ) T4 2N TEET,

LISP (22U T

VMware VMotion 72 E¥ DF —Z L 2 — i~ v DELE Y T 412k > T, =37 947
v A DER MR D LRI, T A —HEBEITEET, 20X RT—F
Z—P—=NEEY T 4 &2t R— T DI, = "OBEIFIC T — S~D AT — N & —
HNHEHTE DM NH Y 9, Cisco Locator/ID Separation Protocol (LISP) D7 —F7 7 F ¥
. T34 AID, DFE V= FKRA L MNID (EID) 2D, 20 —FT 47 nr—
% (RLOC) 7B 22DRIpLFTLNY T A= ML, Y —"OBITE2 747 b
WKL CEBANC LET, 72E 2, =D LW E L, 7 747 Rt —Z
N 74w 0 BERETDHE, V—FHIFH LGN N7 7 v 72V XA L7 FLET,

LISP Ci%, LISP ®iJ7 b >/ —% (ETR) . AJJ b v )v—% (ITR) , 77 —A b
Ky —% <~y 7 VAN (MR) | BEOR~y 7 H—s (MS) REOHDH—EDR—
JZBWTN—Z L= "PRETT, b= PRIONL—F TR SN TND Z & a2 —D
Ty—APMKRy T IN—ENEHTDHE, TONL—ZIIMOTRTCON—Z LT —Z_X—R %
WHL, 729472 MR ENTHAITIRA T 7 4 v 7 2RITZIE LT 7 Rv/MEL, B
LN — DG ETEDL LI LET,

ASA LISP O 7AR— k

ASA X LISP BIRAZFATLERAN, LITOERIZETHLISP N7 7 4 v 7 &L, ¥ —
LV R TAEY) o TERIEDTZOIZZ OfFHRAMEHTE 3, LISPOMGEZITHLRWGA
=LY A NIBET L, NI 74 v 2307 e —F—F =RV, FrLn
PA NTASA T TAHZ A NR—={Z7e0ET, FILOASANR TN A FDASAICNT T 1>
7 BBk LTk, iV ASA X, = NICBIET D720 T 7 4 v 7 BH LA MZED
BIVERHVET, CONTF 740y 7 7ua—3xE iz, ThterR—=v7) £720F
~NTve="7] LMEENRET,

LISPHAIZE D, ASA 7 T A K AL N—%, IHIOK v 7 —4 & ETR £721F ITR TR
DEY SNBLISP T 7 4 v 7 &BREL, 7R—0OFFEEHT LWV A MIEFETEET,
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LISPDHA RFA4

ASA LISP O FEiE

uspoi4 k54> [

cASA VT AZ AUNR—I, A FDT77—A K Fy 7 )—F L ITR £7213 ETR DI

FELTWARERSH Y £, ASAZ T AXZHIKEIEE I AL DT 7 —A MKy
N—RICTHZ LT TEEHA,

cEBEROGBENTE 70 —0RNYR—FEIhET, —wfbkEnhiz7e— BomaEni-o

o—, FEx D=y MIBLTWA 7o — 3 LA —F—ICBEISNnETA,
SEENTEZT7a—ISIPREDT TV r—va N EaERTEY, Hive—L 201+
TOTF7a—NFEL ASAIZ k> T SN ET,

I TARZFVAYIBLIP4D T —RELABEH SE L7 TT, —#HO7 7Y r—a

AT S/ S 0¥ g WA Fi=) /Y SR e

IO 7 o0 —FZIXE PR ACARAR TN T 0 —DE . A—F—OBENIA TR

WATREMR H D £, A AT v a R V—%2RETH L EIT, ZOBRETYR—
SNDBNT T4 I DEATERETEET, T, 7r—FEV T4 BZRAIRRE T
T4 v ZIHIRT DHERH Y £,

Z OMEEIZIE, BEEOMAEICBRT 2R ENTENTVET (ZNHIZOVWTITRTIDE
THBALET) .

1.

(EE) RABMERIIV—NRIP T FLRIZESSBERNLZEID OFIR : 77 —A Ry
T N—HE, ASA 7 T AA NG L TWRWKA MERIIRy hUY—Z |2 EID @M A
TV EEETLIHANHY T, Zod, 77 AXIEET LY —"FEE Ry b

T —27 DHIZED ZHIRTEET, 72& 2L 7 T7AEZNB2O0O% A FOKRIZEE LT
D3, LISPIR3ODH A R TEITEINTWAEGAIL, 77 AZICEHELTWS200H 1
MZk L TOREID & O 250 ERNH Y 7,

LISP T 7 47 AL A7 52 :ASA L, 77— A MRy 7 L—~Z L ITR £7-1%
ETR O CEEIN D EID @M A v —II28W T, UDPAR— k4342 O LISP ~ &
T4 7 ERELET, ASA X, EID &% b~ ID ZB#fHT 5 EID 77— 7 VA REFL
T, ez, 77 —A PRy T NA—FDERFITIPT KL AL TTR £721X ETR D5 T
RUVATLISP b7 7 4 w7 2BETHXLENHY 3, LISP h 7 7 4 w7 iET 4 L7
ENREVETHNTELT, LISP T 7 4 v 7 ARIZZ ZAZREOLFIZEIM LN
LICHEBE LT &N,

BESNEZ NI 747 TO7Rr— YT 424N T 52 —ERAFR) —: VX
2TVFAINIERT T 4w 7T —F YT A 2HINTHILERBLDET, 2L %
X, 7ue—EFE U7 1%, HTTPS N7 7 4 v 7 OAITHIBB LTZV | FFEDH— 3 & DfH]
TRV END T T4 v 7 DORHIBLIZY TX F9,

PFA FID:ASAIL, K7 TAX 2=y bOYA FIDEZHALTHLOVAMEEEZ/HELE
‘/Jﬂo

Ta— YT A EBBNINT DI TAFLNVORE : VJTAZ L)L THL7r— FE
VT 4 ZHNCTAULERHY T, ZOF /A 7080 L 2 ERTH2 LT, BED
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B usprozxxsvaone

TIGADKNT T4 I FEZT AV r— g Akt LT —F Y 5 ¢ 2 HHEICERE
VB 112 | e == N

LISP A AT 2 a vV DOFRE

ATy I

ATy T2

LISPO NI 7 4 v 7 #RELT, V=BV A MEEZBET LRIV e— )T 0 26480
IZTEFET,

1R B
¢ ASA 7 T AFDIARNT A= DFRE (61 X—) I~ T, £V TAX 2=v b &
A MIDIZEY B TET,
CLISPO NT 7 4 v XTI HN A VART Y ay NTFT 490 7T RTEENRNE
D, ZOFMEO—FHE LTLSPD T 7 4 v 7 IO 7 AR ET HMLERDH Y *
‘3‘0

FIE

(fERE) LISPA > AT v ary~yTEHFELT, IPT RLRAZESOTHREF D EID &

fIFR L, LISP OFFiHEAF—2RELET,

a) [Configuration] > [Firewall] > [Objects] > [Inspect Maps] > [LISP] Z 8K L £9°,

b) [Ad]Z27 Uy 27 LT, HiLnwvy FZBEMLET,

o) AWl (BeK403XF) EaME AN LET,

d) Allowed-EID access-list {Z- DV TlE, [Manage] #7 UV v 7 LE T,
[ACL Manager] 2358 & £7,
Ty —A KKy T N—FELITITRETR L, ASA 7 7 A X BEE L TWRNWAR MET
Ty NU—ZIZEIDBHIA v —VZEETLZERNHVET, 20D, 77 RAZI
B4 25— "EidRky N —2Z ORIZEID 2HIBTE£4, 72E 2L 7T AZN2
DDHA FOIITEAE L TWAHA, LISPR3ODH A FTIEITEINTWAHEAIL, 7T %
I LTWA 20D A MK LTOREID &5 0LENH Y £7,

e) 77 AT U A —IVDORENA RIZHE-T, D7e<tH 120 ACE TACL ZEL £,
) MEISUT, WEEF—F AN LET,
Wb —%2a b — Lea1, [Encrypted| 47> a s A% 27V v 7 LET,
o) [OK]Z27 U w27 LET,
PF—ERARY = =L EZBILTLISP A Y AT v a VERELET,
a) [Configuration] > [Firewall] > [Service Policy Rules] DJIE|ZE R L F 9,
b) [Add]EZ VYT LET,

c) [Service Policy] ~—C, A X —T7 = A A~D/—)LE 21T 7 10— L7 )b—)L % il
HALET,
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ATvT3

ATy T4

d)

2)
h)
i)
j)

k)

usp 1 vz~ avonzE |

BEOY—E A R —THEAT 00N HIUE, FORY —IZb—LZBINLE
9, 7 74/ R T, ASA IZ1X global_policy & FETIL D 7 m— L R U—RNEERE
T, RV —%7v—VUZEH LEWGEIE, A2 —T7 24 AT L1 DO —F
AZARY —FERTHZE B TEET, LISPA VAT g i, MWERICET 74 v
AT B0, BETEBIADOT T DA L H—T 2 AT —ERARY >—% i
THMLEEHY A, VT T v I BEGRMOY T AT 56, —/VEiEH
THA =Tz AHANVT DT T 4 v I OFTXTNEELZZITET,

[Traffic Classification Criteria] ~—73""C, [Create a new traffic class] &2 U v~ L. [Traffic
Match Criteria] @ T [Source and Destination IP Address (uses ACL)|& 4 > IZ L E T,
Next] Z#27 U v 27 LET,

AVARTa BTN T T4 v BIBELEY, Y7 —A b Ay )L—F L UDP
A= F4342 DITR £72XETROBIO N T 7 ¢ v 7 &45E L £ 7, IPvd ACL 3 L UVIPv6
ACLDEBLHITHME L TNET,

Next] 7 U v 7 LET,

[Rule Actions] 7 « H#'— K ~_X—F 72X % 7 C, [Protocol Inspection] % 7 Z i L £ 7,
[LISP] F =y /Ry 7 A% AN LET,

(7> a ) [Configure] 27 U w27 LT, AERKLTcA VAR v v~y T HEIRL
7,

[Finish] 227V v 27 LT, 3y—EZXA RY v — L— L ZRELET,

P—EA RV = N—NEZBEMLT, BEERN I 74y 070 — VT 0280 LE

B

a)
b)

¢)

d)

2)
h)

)

i)

[Configuration] > [Firewall] > [Service Policy Rules] DJIEIZER L £,

[Add| 227 U v 7 LET,

[Service Policy] ~—3"C, LISP A VA7 ¥ a VAT AR LY —EARY —%idk
WLET,

[Traffic Classification Criteria] ~X—73"C, [Create a new traffic class] 22 U v 7 L. [Traffic
Match Criteria] @ F#E? [Source and Destination IP Address (uses ACL)| & 4 12 L E 7,
Next] 27 U v 7 LET,

Y=Y A NEERT DL TRERYA MIHEIVYTT L, EVRRA VT H
NIRE T T4 w7 BEELET, ExE 7u—%F U7 4 &Z HTTPS T 7 4 v 7
BRWELIRHEDY —1"~D T 7 4 v 7 ODARITHIRTE £3, IPvAACL I LT IPv6
ACLDELLITH MR LTWNET,

Next] Z#27 U7 LET,

[Rule Actions] 7 4 ¥— K = F 7212 % 7 C, [Cluster] ¥ 7 Z IR L £,

[Enable Cluster flow-mobility triggered by LISP EID messages] = v 7 R v 7 A& A1\ L
ESc N

[Finish) #27 VU > 27 LC, #—ERARY o — L— L ERIFLET,

[Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] >
[Cluster Configuration] DJIH(Zi&R L, [Enable Clustering flow mobility] & = > 7 78 v 7 X % 7

L,

ASAY S R4 .
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ATv TS5 [Applyl 27 Vv 27 LET,

HDISRE A INDEHE

TARARA—1=

IS AREBALT BT, 2T 4K al—al B LR L, JIAZ AUNEERTXE
j‘o

Y EDLDFHLWLWARL—TMEM

VAF— 2=y BT T AZTE A XY ZBIITE £9, [High Availability and Scalability]
DAY= REEAL T FAVEBNMTAHAILELTEET, vAX—2=y FDBAL—T
EMTDE, ZIRAZEHY 7 BFRETE, BNTLHHEAL—T 2=y M TRAH A
VHA—T A XA F—RERETEDHLENI A v bB3HY T,

Frold, Av—Ta=y MIrJ/ AL, 2=y NETE#EI FAZ VU TEARETLHI LD
TEET, 2L, 7 TAZ Y T A F—T I LTztkIL, ASDMt v a Vs s
DT, FHEEHRT DLENDHY £,

188 BRI
e NT AT HANET—RTIE, VAT LAFTAR—ATROFIEEETLET, 72
VAT A AT 4 FXalb—a Ly E— RIZASTWARWEE, [Configuration] > [Device
List] XA VT, 77T 4 TRT A ADIPT FRLAD FIZH D [System]| Z X T N7 U v
7 LET,
A Y N — ETCT— ATy T ar 7 4 Xal—a UERETLHEAIT. A
L—7 2=y NMZT 7B AAEERIP T RLARH D Z 2R LTI IEI,

FIE

AT 71 [Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] >

[Cluster Members] OJIEIZ 3R L £,

ATv T2 [Add) %227V v 7 LET,
ATV T3 WONRTA—ZEZHRELET,

* [Member Name] : 2D 7 T A% A DA D4TE 1 ~ 38 3CF-0 ASCI LFH THE
LET,

* [MemberPriority] : ¥ A ¥ — 2=y MEEHIZ, ZO2=y FOTITA4F VT 1% 1~100
DOHFIPINTRELE T, 1 BDIREDOTTA AV T 4 TT,

* [Cluster Control Link] > [IP Address] : ¥ A ¥ — 7 Z A {lfl) > 7 LRI L%y hU—7 k
T, VI AZGIHY 7 DDA N—EDIPT RLAZEELET,

. ASAY S R4
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k757192 vn—2% ]

+ [Deployment Options] fEIK T, KD [Deploy By] 47> 2 > OWT Izl LET,

* [Sending CLI commands to the remote unitnow] : 7 — F A b Z v 7 a7 1 X o L—
YarvEAL—T (B BHHIPT FLACEFELES, AL—7HEIPT N1 X,
T—PH NAT—FEATLET,

* [Copying generated CLI commands to paste on the remote unit manually] : AL —7 L=
FNOCLI T2~y R&EHy b Ty KA—2 K, F£7213 ASDM O CLI Y — /L % ffi F 5
HEHica~r &4 L E9, [Commands to Deploy] N~ 7 AT, $k AT 572
Woavy FaERL Tat —LET,

Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually 3

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet0/4
no shutdown
cluster group clusterl
local-unit asald
priority 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-slave noconfirm

ATy T4 [OK]ZZ7 Vw7 L, EHI[Applyl 227 U v 7 LET,

ET VT4 TIEAVIN—ITTB

\}

TIGABEDIET JT 4 TIRA NI DINE, VAR T arv 7 4 Falb— g U 3E
HaFlo, #F0Oa=y N TR F Y T2 F 41— LET,

G¥)

ASAD (FENC, FREINA T2y 7 273 —I12L0) ET VT4 712D E, TRTOT—
BAVE=TzAANTY Yy NI ENET, BHEHA X —T A ADHRN T T 4 v
JEEZETEET, NI T4y 7 —5EHRAIELIE. FTRAZY T EHBRA X—T
MZLET, F£RE, TOa=y b a7 T AEZNLERICHIBRLET, BHA X —T = A X
X, TO2=y MBI TAXIP T—ADEZTWMSTZIP T RUAEMH Lol & i & Bk
L0 ET, L, Va—RLTba=y "BV TRAXNTERET 77 4 7 Tlke0Wigh
(7T ABY v T RERIIRIE CREEIRAF LIZGARE) | BHA VX —7 = A ZTEHI
RVET, FNUBEOa LT 4 X o b—va UERITE, ar Y — R — N EHHT MR
HYFET,
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188 BRI
cXNTF AT HEAL T ROLGHIE, ZOFIRE T AT LETAR—ATETLET,
FREVAT A a7 4 F2b—T a3y ET— RIA> TWRWEAIE, [Configuration] >
[Device List] A > T, 77T A4 T72T /A ADIPT RLAD FIZ&H 5 [System] & ¥ 7 /L
7V w7 LET,

FIE

AT 71 [Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] >
[Cluster Configuration] DJIEIZER L £,

AT 72 [Participate in ASA cluster] = v 7 Ry 7 A& 4712 LET,

(G¥)  [Configure ASA cluster settings] T = v 7 AR v 7 A% A 7IZL72WNWTL T3V, 471
THE, TRTDODIVFTRAE a7 4Xalb—arn7 )78, ASDM Mk &S
NWCWDLEHA =T 2 A A FLTXTOA U F—T oA AbT vy NE T L
T, ZOHE, HEiaETT AL, 2 Y — L KR—FTCLIZT 7 EAT D4
ERHY FET,

AT97T3 [Applyl 27 U v 7 LET,

TAA— 1=y rHSDAL—T AUN—DIET7H 57471

AVL—T AUNEIET IT 4 TIZTHIZEFE, WOARAT v T H=FEITLET,

GE)  ASAWIET /T 477 b b, TRXTCOT—H A X —To2Af ANV Yy v NE DT ENET,
BHERA VX —T 2 A ADBNNT T 4 v I B EZETEET, VT 74y 7 7a—%1HH
THIZE, 7 TARAZ VT EREANCLET, BHA X —T oA AL, TO2=v NV
TALIP T—NADHZITMST-IP 7 RUAZMER LTl &k B@kE s e £9, 7272
L. Va—FRLTba=y MV TRAEZNTELET 7T 4 7 TRV (VT AZY 70
N DRECHELRITE LG ARE) | BHA VX — T oA AW £3, TR
DayT 4 Falb—3a AMEET, ar Y=L R R— 2T 0END D 77,

1R BHEIIZ

~NVF arTR AN T FOSREIX, ZOFIEEL VAT LFTAR—ATETLET, /2
VAT A AT 4 F 2 b— g E— FIZAS T WA IE, [Configuration] > [Device List]
RAVT, TIT 4 TIRTNAADIPT RLVADFIZH D [System] =X T N7V w7 LET,
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FIE

AT w71 [Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] ®JI&
(IR L £,

ATY T2 HIRTHAL—T%RINL T [Delete] #7 Vv LET,
AL —F T = A TGy T ar7 4 F¥al—ra IR THY ., ZORTEERSI L
DAL —7 2B TE £,

AT97T3 [Applyl 227 U v 7 LET,

DS RAEIANDBESM

2=y MR Z2AEZMBHIRENTSGS (X, WERBELA X —T A ZADY,
B FREFAUAR—ZFEHTIHET 77 4 7ITLSE) X 7 7 A ZICFEFTHSMNT H 05
NV ET,

188 BRI

c JTARBN T A R—TNCTHITIE, ar =V A= AT OILERHY F
T MDA H—T oA ATV Yy bETENET, 727 L, ASDMTY T AZ Y7
FETHENC LSS, REEZRFEL T a— RNLiro7c8A1E, ASDMTY 7 A4
Vo7 aBOEMITEET, Vr— g, HHA 4 —T = TN R D720, =
VI T IRANT TAEY T R BOENNCT HME—DHETT,

e NTF AT HAN T—ROGAR., ZOFEE VAT LFETAR—ATEITLET,
FLEVAT LA a7 4F2b—T a3y E— RIA>TWRWEATX, [Configuration] >
[Device List] ™A > C, 77T 4 77T XA ADIP T KL AD FiZH 5 [System] & X 7 /L
7w LET,

« 7 T AL ~OFESMeFITT DN, BEEMRRSNATND Z 2R LET,
FIE

ATYT1 ASDMICERET 7 B AL TV R 5EIE, A R —7/UET 2 2=y M ASDM Z #i L T,
ASDM TV 7 AX Y v 7 BUOHMIT L2 LN TEET,
HLWA A= LTEMLTHWRWRY AL—7 2=y DI TAZY) T ex A H—
2=y hPLEHOEMCT S Z LT TE E A,
a) [Configuration] > [Device Management| > [High Availability and Scalability] > [ASA Cluster]|

DIFIZEIR L E T,

b) [Participate in ASA cluster] 7= v 7 Ry 7 A& A N2 LET,
c) [Applyl %7 U w7 LET,
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ATFv T2 ASDMZATCERWEE : av Y=V T, JTAX a7 44X alb— g — FaBlh

ATvT3

L/\i‘g_(]

cluster group name

1

ciscoasa (config)# cluster group podl

JIGABY) T F—T I LET,

enable

552505 DBHE

ATy T

ATy T2

T FGAENLREIWIET DIE, VTAX T— ATy ar7 4 Xal— g2k
ZHIRT AMLERH Y T, FALUAOBIEDa L T 4 FXal—aif (FIA4~) 2=y
ENASREENT) FUTHDHIZO, 7T AXNLMIETEE, 7 TRAZ) U TRiODa 7 4
Xal—araR\y I Ty TN T 50, IPT NLADHEEZRTH2Ha 7 4 Fa
L—ya VEBEELTYIOOLROET Z &L MBI 7,

1R BHHIIZ

ay YV —)LiR— N EHTAMNEND YV ET, 7 T7AXDa T 4 Fal—a U EHIRT S
L BEHA LU =T 2 A RE T TAAFNEY) I 2G5 T_XRTCDOA A —T A ANV ¥ v b
2y EnET,

FIE

Y 2=y bOYE, 7 TAZ VT EROLICT 4 =TT LET,
cluster group cluster_name no enable

1 :

ciscoasa(config)# cluster group clusterl
ciscoasa(cfg-cluster)# no enable

JIARZY TR FY 2=y b ETA R =T IR TOLRIE, 207 4 Fab—
TalyEEEITH)ZEIXTEEREA,

JTAB AT 4 Xal—varE7 VT LET,

clear configure cluster

ASAIL, BEA LV H—T 2 A R T TAFFHEY) 7 ETLTXTOA B —T o f A ¥ v
rET U LET,
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ATvT3

ATy T4

ATy TH

ATvT6

2z28—2=y tozE [

ISR AR —T oA XA ET— RETF 42— N2 LET,
no cluster interface-mode

T-RNEar 74 Xalb—Ya VZBRFSRRVED, FBTY By N O0ERH D &
R

Ny T o7 ar7Z4Xalb—=varBbdGh, FTar74Falb—vaiinys7y
T arZ4FXal—varegar—LET,
copy backup cfg running-config

1 -

ciscoasa(config)# copy backup cluster.cfg running-config
Source filename [backup cluster.cfg]?

Destination filename [running-config]?
ciscoasa(config) #

AT 4 X2l —TarEAX— T v IREFELET,

write memory

R T o a4 Xal—ra BN RWEEIT, BT 72 2H/BRELET, 2& %
WE. AV H—T=2ARAIPT RLAEZEFEL, ELWKA MEETLET,

v FOZEHE

&

VAL — 2=y NEERTHRKBOTIEL, ~AX—a2=y NTITFAZ Y U T HEHICL,
LW RAY —DFINEfF- T, VTAX Y T E/ERMNCTLHHETT, v AX—|C
ThHr=y NEREICHRET DM ERHLGAIX. ZOHOFIEZFEM LET, 72720, FRk
HEPRSEEDLE AT, ZOFIEEFH L Ty AY —2=y NEBZEHT 5 & T TORRN
Ry 7S50 T, il AF— 2=y s ETEHRZBEHELTOIULERHD 97,

YA — o=y FEERT LT, ROFIEZFATLET,

1R BRI

YNATF aArTXA LT RO, ZOFHE VAT LETARN—ATIITLES, £72
VAT A AT 4 X2 b— g E— RIZAS TV WEAIE, [Configuration]>[Device List]
RAVT, TITATIRT A ADIPT FLAD FIZH D [System| 2 X T NV7 Vw7 LET,

FIE

[Monitoring] > [ASA Cluster] > [Cluster Summary] % #R L ¥ 4,

ASAY S R4 .



AsAY 524 |
B /5xs265c0a< roxs

AT w72 [Change Master To] Kz v 72 7 URA KD, YAX—|ZTHAL—T 2= NERINL,
[Make Master] #7 U v 7 L £,

RT9T3 vA¥— 2=y NMEROWHRZRDONET, [Yes] &2 Vw7 LET,

ATV T84 ASDMAEKT L, AL 7 TAXIPT RUAEMER L CHEHEL E7,

HDSRBAEAETHOATY FOET
aw L REZ TAZNDOTRXTO AN, FRFFED A L ANTRET B2, ROFIEE
FITLFET, show 2~ RETRTOALUNIZEET B L. T_XTOHIIBIE S THIE
Da=y hOaALY—=VIEKREINET, ZTOMOa~ R, 72L& 21X capture <° copy & .
7T ARBIRTOFIITEIFHTE £,
1R BHIIZ

av L RIA A B—T 2 A Y=L TZOFNEEFITLET, [Tools] > [Command Line
Interface] % &R L F 7,

FIE

A RETRTOAUNIERFLET, 2=y MERERE LGSR, FED X U NIZERE
SNFET,

cluster exec [unit unit name] command

51

ciscoasa# cluster exec show xlate

AR = e —E KR HIZIE, cluster execunit? FAED 2= N Z R TR TOLFINE
REIND) L ATITBH, show cluster info =~ KA AN LE9,

151
FLXY ST v 774 NETTAZNOTXTCO=y M BREEFIZ TFTP %—3Z
A —F5HI2F, vAF— 2=y FTROa<> NE A LET,

ciscoasa# cluster exec copy /pcap capture: tftp://10.1.1.56/capturel.pcap

HBEDPCAP 7 7 A )V (2= FIrBH 12T D) NTFTPH—NZab —InEd,
SEAEDF ¥ T TF ¥ T 7 A NVAITIFHEMIZ = FMAPMIIE 4L, capturel_asal.peap,
capturel asa2.pcap 72 & L7203, ZOFITIE, asal BE Wasa2 237 7 AKX 2= k
4T,
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ROFITIL, cluster exec show port-channel summary =~ > RO T, 7T AXD
& A 2 73— EtherChannel 53RN FR I N TWET,

ciscoasa# cluster exec show port-channel summary
master(LOCAL) :***********************************************************

Number of channel-groups in use: 2

Group Port-channel Protocol Span-cluster Ports

—————— B et st T i e T e e
1 Pol LACP Yes Gi0/0(P)

2 Po2 LACP Yes Gi0/1(P)

Slave:******************************************************************

Number of channel-groups in use: 2

Group Port-channel Protocol Span-cluster Ports

—————— B et st T i e T e e
1 Pol LACP Yes G10/0 (P)

2 Po2 LACP Yes G1i0/1 (P)

ASA D SARADE=RYY

TITAXDRE LB AT ABLIOR NI TN a—TFT 4 VT TEET,

DSREAT—R3ADEZZ)Y
7T AEDREDOE=HY U 72OV TIE, ROBEHEZSHL T EE0,
* [Monitoring] > [ASA Cluster] > [Cluster Summary]

TS N, T OA =y N T REDFEDMD =y FOBFRAFER SN E
T, Flo, ZOXAL L TTIAVVEEEERTHENTEET,

* [Cluster Dashboard]

I A=< U EEE DR — L ~X— D [Cluster Dashboard] & [Cluster Firewall Dashboard] % 15 H
LTI TAZZE=HTEET,

DSREIEERDINT Y DX TF ¥

I TGAZTONT Y FOF¥ T F v IZONTEL, ROEHZSZRL T ZEW,
[Wizards] > [Packet Capture Wizard]

JIGAABRD N T TNy a—T 4 TP R—rT510%, ~AX—a2=v h L TOI T A
HAEE N T 74 v I DX TFraAF—TNILET, ZNT, FT7AXHNDOTITDA
L—7 2=y NCHHBIMIZA X—T IR0 £97,

DSRAB YY—ZADE=ZRZY Y

IGAE Y ) —ZADE=F Y I ONTIE., ROBEFEREZRBL T EEN,

ASAY S R4
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* [Monitoring] > [ASA Cluster] > [System Resources Graphs] > [CPU]

TDORAUTIE, I TAE AR CPUFHRERT VT 7F-137 — 7 NV EER
TAHZENTEET,

* [Monitoring] > [ASA Cluster] > [System Resources Graphs] > [Memory], Z D<A > TiL, 7
T AKX NEIRD [Free Memory] & [Used Memory] #&K/R$ 57 T 7737 —7 v %
BT 2 Z & TEET,

V2R3 b2 7490DEZZ)2Y
JITAR NTT 47 DE=ZZY U TIZONTIL, ROBE@mEAESHEL T IEIN,
* [Monitoring] > [ASA Cluster] > [Traffic] > [Graphs] > [Connections]s

DXL UTE, I TAZ AUNRBIROE i E T 77 7 £33 7 — 7 NV EERT 52 &
NTEFET,

* [Monitoring] > [ASA Cluster] > [Traffic] > [Graphs] > [Throughput],

DXL TIE, VIAZAUNEERD N T T 4 T DAN—T" NeRmT 7T 7 F7201%
T—TIWVEERT D ENTEET,

— P4 — »
DSARHEH)ODEZR DY
7T AL DIREDE=HY 72O TIE, ROBEHEZSRL T EE0,
[Monitoring] > [Properties] > [System Resources Graphs] > [Cluster Control Link],

ZDORA LTI, 77 AZHIEY 7 O [Receival] 35 & O [Transmittal] & £ HE % F£rd 5
T 7 FEET TNV ERT D M TEET,

DSRIDIN—T4 2 TDE=Z2YT
I TAREDN—T 4 ZIZONTIE, ROBHAZZHRL T30,
* [Monitoring] > [Routing] > [LISP-EID Table]
EIDs &4 M ID #/”" 3 ASAEID 7—7 VAR R LET,

— N N N E I_|_I
D2ARZNY0OOF T DERE
JIAZY T DuX T OFREICDONTIE, ROBEEHEZZHRL T IZIV,
[Configuration] > [Device Management] > [Logging] > [Syslog Setup]

7 T ABZNOE L= ME, syslog A v E—TEM@BNZAERLET, F—F32e57 34
A IDfF & CTsyslog A v E—VHERTDHIENTE, VITRAXANDOE—FI3R 2=
EPHEDA Yy E—=VDEIIZREDLZ ENTEET,
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ASA U S RZ1)25DH

PLFOBNZIE, —RBEATOD ASA DT FAXEEOT X TOaAL 7 4 X2 lb— 3 RN
GENET,

ASA BLXURAYFDIAVT4FalL— 3yl

WDaLy 7 4Falb—aflid, ASAL AL v TFMORDA o H—T =2 AR LET,

ASAAL B —D14R ARAYFALEZ—T AR
GigabitEthernet 0/2 GigabitEthernet 1/0/15
GigabitEthernet 0/3 GigabitEthernet 1/0/16
GigabitEthernet 0/4 GigabitEthernet 1/0/17
GigabitEthernet 0/5 GigabitEthernet 1/0/18

ASA DEETE
LAY DA VB —T AR E—FK

cluster interface-mode spanned force

ASM Y RA—TJ—hrR ISy TarvIqaFXal—3y

interface GigabitEthernet0/0
channel-group 1 mode on

no shutdown

!

interface GigabitEthernet0/1
channel-group 1 mode on

no shutdown

!

interface Port-channell
description Clustering Interface
!
cluster group Moya

local-unit A

cluster-interface Port-channell ip 10.0.0.1 255.255.255.0
priority 10

key emphyriO

enable noconfirm

ASA2 R L—T J—hrR Sy FTavds¥alL—3ay

interface GigabitEthernet0/0
channel-group 1 mode on

ASAY S R4
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no shutdown

|

interface GigabitEthernet0/1
channel-group 1 mode on

no shutdown

|

interface Port-channell

description Clustering Interface

|
cluster group Moya
local-unit B

cluster-interface Port-channell ip 10.0.0.2 255.255.255.0

priority 11
key emphyriO
enable as-slave

TAR—AA R =D R AV T4FalL—3Y

ip local pool mgmt-pool 10.53.195.231-10.53.195.232

interface GigabitEthernet0/2
channel-group 10 mode active
no shutdown
|
interface GigabitEthernet0/3
channel-group 10 mode active
no shutdown
|
interface GigabitEthernet0/4
channel-group 11 mode active
no shutdown
|
interface GigabitEthernet0/5
channel-group 11 mode active
no shutdown
|
interface Management0/0
management-only
nameif management

ip address 10.53.195.230 cluster-pool mgmt-pool

security-level 100

no shutdown

|

interface Port-channellO
port-channel span-cluster
mac-address aaaa.bbbb.cccc
nameif inside
security-level 100

ip address 209.165.200.225 255.255.255.224

interface Port-channelll
port-channel span-cluster
mac-address aaaa.dddd.cccc
nameif outside
security-level 0O

ip address 209.165.201.1 255.255.255.224

. ASAY S R4
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Ciscol0OS XA/ v FNDaAV T4 FalL—>ay

interface GigabitEthernetl/0/15
switchport access vlan 201
switchport mode access
spanning-tree portfast
channel-group 10 mode active

|

interface GigabitEthernetl/0/16
switchport access vlan 201
switchport mode access
spanning-tree portfast
channel-group 10 mode active

|

interface GigabitEthernetl/0/17
switchport access vlan 401
switchport mode access
spanning-tree portfast
channel-group 11 mode active

|

interface GigabitEthernetl1/0/18
switchport access vlan 401
switchport mode access
spanning-tree portfast
channel-group 11 mode active

interface Port-channellO
switchport access vlan 201
switchport mode access

interface Port-channelll

switchport access vlan 401
switchport mode access

ASAY S R4
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ATAVILEDT7AT7o4+—IL

ASA1

management
10.1.1.1/24 (Pool: .2-.9),
2001:DB8::1002/64
(Pool: 8 IPs)

ten0/8
man0/0
ten0/8

Cluster Control Link
192.168.1.1, .2, and .3

<J___ port-ch1 Spanned | _I>
port-ch1.10 inside VLAN 10 10.10.10.5/24, 2001:DB8:2::5/64
MAC: 000C.F142.4CDE | |
port-ch1.20 outside VLAN 20 209.165.201.5/27, 2001:DB8:2::5/64

MAC: 000C.F142.5CDE

—

|

=]

port-ch5
VLAN 10, VLAN 20 Trunk

Switch

|VI_AN 20

U

—

Client

b

‘I
333221

Server

B Xo2 0T 40 RALUDODT—X N7 7 4 v 7121%, #7225 VLAN BBEA T B
£, 72&2IENEER Yy F U —27 IZiZ VLAN 10, Mty FU—27121X VLAN20 & L ¥
To FASAITH—DOYEAR— IR’ HY | INTAAL v F EliINV—F IR INET, T
XU TWAF—=T NI TNDHDT, WELY 7 EOFTXTORr y hA3802.1q 7 7 &L
SN FEd, ASAIX. VLAN10 & VLAN20 DO 7 7 A4 77—/ TT,

A%y R EtherChannel 295 & XX, AA v FHTTRTOT—H Vo I BRITNL—TE
FUT 195 EtherChannel & 720 F£3°, ASA D 1 OBFHARTREIC R > =883, A4 » FI35k
D=y "NETrT 7 4 v 7 BB LET,

BAZY rDAVE—T AR E—F

cluster interface-mode spanned force
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ASMMYRA—J—hrR Sy TavIaFxal—3y

interface tengigabitethernet 0/8

no shutdown
description CCL

cluster group clusterl

local-unit asal

cluster-interface tengigabitethernet(0/8 ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable

enable noconfirm

ASA2 R L—T J—hrR by T avTaF¥al—>3ay

interface tengigabitethernet 0/8

no shutdown
description CCL

cluster group clusterl

local-unit asa2

cluster-interface tengigabitethernet0/8 ip 192.168.1.2 255.255.255.0
priority 2

key chuntheunavoidable

enable as-slave

ASA3RL—TJ J—hrR ISy FTarvI4FalL—>3ay

interface tengigabitethernet 0/8

no shutdown
description CCL

cluster group clusterl

local-unit asa3

cluster-interface tengigabitethernet0/8 ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable

enable as-slave

TRAA—AB—TAR AV T4 FalL—ay

ip local pool mgmt 10.1.1.2-10.1.1.9
ipv6 local pool mgmtipvé 2001:DB8::1002/64 8
interface management 0/0

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
ipv6 address 2001:DB8::1001/32 cluster-pool mgmtipvé
security-level 100

management-only

ASAY S R4
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no shutdown
interface tengigabitethernet 0/9

channel-group 2 mode active

no shutdown

interface port-channel 2
port-channel span-cluster

interface port-channel 2.10

vlan 10

nameif inside

ip address 10.10.10.5 255.255.255.0
ipv6 address 2001:DB8:1::5/64
mac-address 000C.F142.4CDE
interface port-channel 2.20

vlan 20

nameif outside

ip address 209.165.201.1 255.255.255.224
ipv6 address 2001:DB8:2::8/64
mac-address 000C.F142.5CDE

Cluster Control Link
port-ch1
192.168.1.1, .2, and .3
ASA1
§ T 7\ ten0/6
al | || ten07
A A Y ten0/8 \P (€n0/9 A
= =
- zo | =3
S N 55 2IBM 08 B
el 1T g3 213 8203
8 AW SR_978 =R B
s § O =N _O:"J = =3
oy Opa T 2.0 o
=5 n8aw —-—5a8sT =5
R O80T rS0o =
vy S man0/0 P 3
. 58 2 32 2
SO\ 1| S5 g\ tenos me
gl o | [zl ] ten0r7 &
U 2 /2 teno8 >
V V V V
man0/0 |
management
10.1.1.1 (Pool: .2-.9),
2001:DB8::1002/64 (Pool: 8 IPs)

WSy hT—7 LRy U= DRIT, NI 74 v 7 2BIICHBECTCE £7,
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rs57cvs0n [

FoRICRT I OIC, ERNZ—IF D A3 R EtherChannel 233 0 . NERA A v FIkr ST
WET, MHFITERCH Y, AL v TFICER SN TWET, HETHILE, £ EtherChannel
FIZVLAN S 7oA v Z—T = A Z%AETHZ L b TEET,

FE1ZY rDAVE—T AR E—F

cluster interface-mode spanned force

ASAMM Y RA—T— RSy TavIasFXal—ay

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asal

cluster-interface port-channell ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable

enable noconfirm

ASA2 R L—T J—hrRA LSy TavIq4F¥xaL—3ay

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asaz

cluster-interface port-channell ip 192.168.1.2 255.255.255.0
priority 2

key chuntheunavoidable

enable as-slave
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ASA3RL—T J—hrR LSy T avTaFal—>ay

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asa3

cluster-interface port-channell ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable

enable as-slave

TARARA—A B —TDA R AV T4Falb—3Y

ip local pool mgmt 10.1.1.2-10.1.1.9
ipvé local pool mgmtipvé 2001:DB8::1002/64 8
interface management 0/0

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
ipv6 address 2001:DB8::1001/32 cluster-pool mgmtipvé
security-level 100

management-only

no shutdown

interface tengigabitethernet 0/8

channel-group 2 mode active

no shutdown

interface port-channel 2
port-channel span-cluster

nameif inside

ip address 10.10.10.5 255.255.255.0
ipv6 address 2001:DB8:1::5/64
mac-address 000C.F142.4CDE

interface tengigabitethernet 0/9

channel-group 3 mode active

no shutdown

interface port-channel 3

port-channel span-cluster

nameif outside

ip address 209.165.201.1 255.255.255.224
ipv6 address 2001:DB8:2::8/64
mac-address 000C.F142.5CDE
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Z/%> F EtherChannel £ /Xy 07y T U2y (ED8TH T4 TBRAINA)

A /N> K EtherChannel L/ N\ v o7y T )2y (RED8TFTHUT47/8
AR INA)

¢k D EtherChannel DT 7 7 4 7 AR— MO KEIL. AA v TFR/NLO SIZHIBEINET, 8
BDASANGID 7 T AHX NV | EtherChannel (2= h&H7-0 2K — s &EI 0 Y4 T4
iE. A6 R— DI BL8AR— &2 AZ N, T— NIZTHHXERHY £9, ASAIX, £
VoD &T VT4 TERIFAZ L AALIT H0%, LACPEEHL CxrIv=—hLET, VSS
F721EVvPC 2 LT~ /LF A A v F EtherChannel % A x—7 /M L7261, A1 v FRID
TLEMEZFEHTEET, ASATIE, TRTOYHKR— bBRRIICAR v NEFIE, RIZK— b
FFEICIE_RDNET, WOR T, BEEO/NINWR— IR 2% —] K—F&7b (=&
Z 1% GigabitEthernet 0/0) . flL 77y AL —7 | R—r&720 £F (72 & 21F GigabitEthernet
0/1) o ™= R =THEHGORMIMEERIET D2LERHY 9, 2FD, TRXTOYAX—T
VIWIIEBDAAL o TFREERERY TRTORAL—T VU 7 3BIDOAAL v F RN e 7> T
WAHRENH Y £9 (VSSVPC MEH SN TWAEHE) , ROKIX, 77 AZIIBINT 5=
=y NBHEZTY 7 OB LIZE X2, EOXHT2DnERLTNET,

Houter or
Access Switch

Switch 1

Virtual Switch Link

Router or
Access Switch

Switch 2 Switch 1

Virtual Switch Link

Router or
Access Switch

Switch 2 Switch 1

Virtual Switch Link

Switch 2
==

1. Up to 4 units

2. 5th unit joined

333218

3. Maximum of 8 units

JFRIE LT, HIDIZTF ¥ RmNAVNDOT 7T 4 7 h— bNaeEiRRILL, #0952 T, 777477
VAF—IR— R e T I T AT RAL—T R = FDEONT 2B ET, SEHOD2=> I
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B =< EEtherchamnel /Xy ST YT UL Y HEERDETH T TBRE L)

NI TAZIIBMUIZEEE, T 7 4y 7 RNFA_NTO2=y MCHFEIaBShRnZ &
ICHEELTEE N,

Vo7 E3T A AOBEREAE L&, RUFAITOUEESNET, TO/RE, v—F
N U TR R BEEIZIT R B2 b D FT, ROMIE, 4=y FDIT T AH
EFRLTWET, Z0Oa2=y D 12T, H—-U U IEENEELTNET,

37

ASAL

?\ > b U — 7 WNIZHEHL O EtherChannel 3% ET 5 Z L &2 bivE T, IROKTIE, EtherChannel
N el RN %$_1o%0i#AmA . —7J7® EtherChannel T~ A % — &xv~7@ﬁ
ﬁ@)/ﬁﬂﬁ RugIZ 72 o 7085 77%&@%M@éhi¢0;hi Z® ASA B3 T
WCNER R > b T — 27 ~D i & %ofw ZHb T, MRy NT—I b T 7
I EZETHDE T TY,
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Router or
Access Switch

T
7 <

Virtual Switch Link

"“hﬁ:"zraﬂ"

Inside

Switch 4

Router or
Access Switch

BAZY DA E—T AR E—F

cluster interface-mode spanned force
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interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9

channel-group 1 mode on

no shutdown

interface port-channel 1

description CCL

cluster group clusterl

local-unit asal

cluster-interface port-channell ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable
enable noconfirm

ASA2 R L—TJ J—hrR by TavdasF¥al—>3ay

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9
channel-group 1 mode on

no shutdown

interface port-channel 1
description CCL

cluster group clusterl
local-unit asa2

cluster-interface port-channell ip 192.168.1.2 255.255.255.0
priority 2
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key chuntheunavoidable
enable as-slave

ASA3RL—T J—FrR ISy T avIqs¥alL—>ay

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9

channel-group 1 mode on

no shutdown

interface port-channel 1

description CCL

cluster group clusterl

local-unit asa3

cluster-interface port-channell ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable
enable as-slave

ASMMRL—T J—hrR LSy TavIqsFaL—3ay

interface tengigabitethernet 0/6

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/7

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/8

channel-group 1 mode on
no shutdown

interface tengigabitethernet 0/9
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL
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cluster group clusterl

local-unit asa4

cluster-interface port-channell ip 192.168.1.4 255.255.255.0
priority 4

key chuntheunavoidable

enable as-slave

TAR—AA R —DA RV T4FalL—3Y

ip local pool mgmt 10.1.1.2-10.1.1.9
interface management 0/0

channel-group 2 mode active
no shutdown

interface management 0/1

channel-group 2 mode active

no shutdown

interface port-channel 2

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
security-level 100

management-only

interface tengigabitethernet 1/6

channel-group 3 mode active wvss-id 1
no shutdown

interface tengigabitethernet 1/7

channel-group 3 mode active vss-id 2

no shutdown

interface port-channel 3

port-channel span-cluster vss-load-balance
nameif inside

ip address 10.10.10.5 255.255.255.0
mac-address 000C.F142.4CDE

interface tengigabitethernet 1/8

channel-group 4 mode active vss-id 1
no shutdown

interface tengigabitethernet 1/9

channel-group 4 mode active wvss-id 2

no shutdown

interface port-channel 4

port-channel span-cluster vss-load-balance
nameif outside

ip address 209.165.201.1 255.255.255.224
mac-address 000C.F142.5CDE
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L—Fv kE—Fy4a to528yvs0ovEE I

W—T Y RKE—FHYA L EHISRE) 25D 0TVETE

A3 K EtherChannel ZfEH L7=/b—7 v K £ — RIZx$T 5% A MEZ ZAZ U T ORH)

X, OTV Ok E L E=X UV o I Lo THRARY £9, OTV X, DCI &RIZ 7y M &
k952 & T, BEARAKREZE-LET, OTVIL, T —7/LICMACT R L R &5 4
HEXIZOH, DCIERIZZ=F ¥ A N Xy MEHRELET, MAC 7 R L A OTV ik

T MFER SN TW WSS, =%y A N Xy MI Ry 7SiLETd,

0TV FREDHI

//Sample OTV config:

//3151 - Inside VLAN, 3152 - Outside VLAN, 202 - CCL VLAN
//aaaa.1111.1234 - ASA inside interface global vMAC
//0050.56A8.3D22 - Server MAC

feature ospf
feature otv

mac access-list ALL_MACs
10 permit any any
mac access-list HSRP_VMAC
10 permit aaaa.1111.1234 0000.0000.0000 any
20 permit aaaa.2222.1234 0000.0000.0000 any
30 permit any aaaa.l1111.1234 0000.0000.0000
40 permit any aaaa.2222.1234 0000.0000.0000
vlan access-map Local 10
match mac address HSRP_VMAC
action drop
vlan access-map Local 20
match mac address ALL_MACs
action forward
vlan filter Local vlan-list 3151-3152

//To block global MAC with ARP inspection:
arp access-list HSRP_VMAC_ARP
10 deny aaaa.1111.1234 0000.0000.0000 any
20 deny aaaa.2222.1234 0000.0000.0000 any
30 deny any aaaa.1111.1234 0000.0000.0000
40 deny any aaaa.2222.1234 0000.0000.0000
50 permit ip any mac
ip arp inspection filter HSRP VMAC ARP 3151-3152

no ip igmp snooping optimise-multicast-flood
vlan 1,202,1111,2222,3151-3152

otv site-vlan 2222
mac-list GMAC DENY seq 10 deny aaaa.aaaa.aaaa ffff.ffff.ffff
mac-list GMAC DENY seq 20 deny aaaa.bbbb.bbbb ffff.ffff.ffff
mac-list GMAC DENY seq 30 permit 0000.0000.0000 0000.0000.0000
route-map stop-GMAC permit 10

match mac-list GMAC_DENY

interface Overlayl
otv join-interface Ethernet8/1
otv control-group 239.1.1.1
otv data-group 232.1.1.0/28
otv extend-vlan 202, 3151
otv arp-nd timeout 60
no shutdown
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interface Ethernet8/1
description uplink to OTV_cloud
mtu 9198
ip address 10.4.0.18/24
ip igmp version 3
no shutdown

interface Ethernet8/2

interface Ethernet8/3
description back to default vdc e6/39
switchport
switchport mode trunk
switchport trunk allowed vlan 202,2222,3151-3152
mac packet-classify
no shutdown

otv-isis default
vpn Overlayl
redistribute filter route-map stop-GMAC
otv site-identifier 0x2
//0TV flood not required for ARP inspection:
otv flood mac 0050.56A8.3D22 vlan 3151

YA FEEDEOICTBHEGZOIV IS ILIDER

A SRE T LTI, 70— UV MACT FLAZZNLL E7 ey 7 L THED LD
(2. T4 NE % OTV O HIRT 20ENH Y £3, BERW ONOBINRER DY £7,

BEEEL CWD YA FTOTV AA v F LD ASA 72— )L MAC 7 RLVRIZKRITHAXT 4 v
7 2 M) EBINTALERSHY T, 2o FUIZko T, KEHAIO OTV (34— — 1
A AV HE—=T oA AZINHEOTY N ZBIMTEET, =1t T 472 MZASA HO
ARP = MU BT TIZH 256 (ZHIBFOBRROSETT) | ARP IFHEE SRV
T, ZOFERLIIZRD FT, LER-T, OTVITEEET — 7 /LT ASA 7 7 —3L MAC
T R RAZEETHESITIHY FH A, OTVICITEEET —7 LN 12— LMACT R L&
B, OTV OFFHZTEIZOTV IFA— N~ A f X —T 2 A A% N L TL=F % A h X
Ty NET Ty T 4T LRNDOT, =%y AL Xy NI — b0 7 e —30 MAC
T RV Ry 7, BFOBRITUIB S E 7,

//OTV filter configs when one of the sites is down

mac-list GMAC A seq 10 permit 0000.0000.0000 0000.0000.0000
route-map a-GMAC permit 10
match mac-list GMAC A

otv-isis default
vpn Overlayl
redistribute filter route-map a-GMAC
no vlan filter Local vlan-list 3151
//For ARP inspection, allow global MAC:
arp access-list HSRP_VMAC ARP Allow
50 permit ip any mac

ip arp inspection filter HSRP VMAC ARP Allow 3151-3152

mac address-table static aaaa.1111.1234 vlan 3151 interface Ethernet8/3
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//Static entry required only in the OTV in the functioning Site

oY A FBERX LGSR, 7 VXEHEBIMLT, OTV TCIDAZ T 4 v 7 T kY
FHIRTAMLERHY FET, Fu—)LMACT RLADF—R—L A = "N &7 VTT A5
Wi, WHD OTV THAFI v MACT RLAF—T %7 V7352 EREFICEET
—g—o

MAC7 FLR T—JILDU )T

YA R E T L, Zu—SLMACT RLANDREZT w7 = MUNOTVISENEN
HEETE, D OTV A —R—L A f L H =T =2 AD T 11—V MAC 7 KL R Z528 T
EXDHEOCTHDHERHY T, OV A FREEBILEZL, 260 NI ET VT T4
ERH D FET, OTV DEEET — TN ZNHDT Y Y RRNT & 2HERT 572012, MAC
T RUVA T =T N ELTHELTIEIN,

cluster-N7k6-0TV# show mac address-table

Legend:

* - primary entry, G - Gateway MAC, (R) - Routed MAC, O - Overlay MAC
age - seconds since last seen,+ - primary entry using vPC Peer-Link,
(T) - True, (F) - False

VLAN MAC Address Type age Secure NTFY Ports/SWID.SSID.LID

————————— B D T R e T e L L e P Lt
G - d867.d900.2e42 static - F F sup-ethl(R)

0 202 885a.92f6.44a5 dynamic - F F Overlayl

* 202 885a.92f6.4b8f dynamic 5 F F Eth8/3

O 3151 0050.5660.9412 dynamic - F F Overlayl

* 3151 aaaa.l1111.1234 dynamic 50 F F Eth8/3

OTVARP v v aDE=A )Y

OTVIiZ. OTVA v H =T 2 A AR THEEHLIZIP 7 FLRIZxT 27 2% ARP ~D ARP
FyviarbfERFLET,

cluster-N7k6-0TV# show otv arp-nd-cache
OTV ARP/ND L3->L2 Address Mapping Cache

Overlay Interface Overlayl

VLAN MAC Address Layer-3 Address Age Expires In
3151 0050.5660.9412 10.0.0.2 1w0d 00:00:31
cluster-N7k6-0TV#

YA EYSRE ) 2T D

ROFITIIYR—FSND 7 FTAZDEANEZRLET,

BRI B3 —T AR INL—T YK E—F /=AY X 54 EDHI

WOFITIL, WERV—Z LANERL— 2 ORICELE SN2 (V= AT T RFEAN) 2 50F—F &
VE—DFENFNIZ2DODASA T T AZ AURANBLBEERLET, 7T AF AT,
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. Y4 FEBEDOMACT FLABEUIP 7 FLAZEFERALIzR/I K EtherChannel )L—T v K E— FD1l

DCIFRH D7 ZAZHIEY v 72X TSN TWET, &7 —F B ¥ —DONEHL—F &
S L—H1X, OSPF &L PBRE7IXECMPEZMEH LTI T AZ AV NRBTRTI 7 4 vV & —
RANZUALET, DCLIZEITA R L— b EH VY TEHZEIZED, FFEDOYA FOT T
DASA T TAL AUNPE G LIRWRY, NT 7 4 v 7 13&T —% 2o X —NICHEFES L
T3, 1290V A FDTRTCDI T AL AU NIEENEAE LSS, V77 4 v 713K —
25 DCIRERH TV A FD ASA 7 T AHX AN ZkLNET,

S al

e

Qiernet J
Router -~—~—~f—'/ Router

1
e Higher cost foute Higher cost route — R
Outside C Out5|de

ﬁ_,

Data Center

' : Interconnect
Cluster Control I_< E
1 [
OSPF S OSPF
E Inside j
e, _— "
T T
e Higher cost route Higher cost route e
— N
Router Router
Data Center 1 Data Center 2

Y4 FEBADMACTY KLRAEELUIP7 KL RZ{FEAL =R/ KEtherChannel )L—TF ¥

rFE—

D15

WOHITIL, &V A bOF— b =g —F ENEX Y NT—FRIICRESINTE (1 —A R

Tz A NMEAN) 200T =X —DENENUI2 DD I TARZ AN LGEERLE
T 7 T7AZ A NE DCIEH D 7 F AZHIH Y o 712 Ko TSIV TWET, £ A |k
DY T AE AL, NEE L OSNE F Ox v h DU — 27 2% L A,3 R EtherChannel % {#
L= AL v FITHH LT, 4 EtherChannel X, 7 7 AXNDTRTD Y ¥ — T A
RUanEd,

7 —% VLAN (X, A—_—L A FZ7 2 AFK— Mdfb (OTV) (EEREEOH D) %A
LTCHA MEICIEESNE T, N T 74 v I BT TAXGETCTHDIHAITNT 7 4 v 7 3DCI
i L TP A MIEEFE SRV E 22T DIE, /r—YLMACT RL A&7y
THT4NEEENTOILERNHY ET, 1204 FOI T AKX 2=y FPEERFEIC/L-

370998
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H4 FEBEDOMACT KLRBEUIP 7 KLRAERA LR/ F EtherChannel L—7F v K E— kopl [

58, b7 40 MOV A DI T AX 2=y MIEEEND LT 4V Z BHIFRT
HVENBHY FT, VaclZHH LT, 22— S)LOMACT RLADT 4 VE U v 74 A NE
BHVET, BB U—XTA4 0 — FBEH I N Nexus 2 EDQO—FDAA »FTiL, 7 a—
ZSOVMAC T RLVAMMBD ARP X7y a7 a vy 73T 5720 ARP A VAT v a b H
THLERHD £, ARPA VAT 23 Tlid, ASATY A FOMACT KLAREH A +D
IP7 RLVADWMFERETHDHLERHYET, 14 NOMACT RLADHZREHRET HLHEE
WP ARP AV ART g UEBHICL T ZE, Ffic>nwTix, hh—7y RE— K
A N ZTZAZ VT D OTVEE (953—) | 2L TLEEEN,
JIARE, Wiy NU—27 D~ oA L L THRELE T, T XCHOIVTAFX 2= |k
MTHEAEIND 70— VRIEMAC X, N7y NEZETHORFICERESNET, %
fF Ty NI, £DC T TZAZMNLOH A NEAEDMACT FLAZMERALET, ZOREIC
X0, MACT7 7 v B TORNEZRS 2ODRR DR — N THEOHA "B ELE 77—
AMACT RLUAZAA v FNEETHOEIELET, bV, A4 v FiT¥ A FDMAC
T RUVADOREFE L ET,
ZOTFIVATIEH, ROEHITD £T,
« JTAEANBEEEINDTXTOHII Ny b, ¥4 POMACT RVAZEEA L,
F—HEL A —Tr— T RENET,

¢« VTG ARADTXTDAN NNy M, Ze— UL MACT RLAZFEHLTEEINS
728, WHFDOYA FhTHTIhDL=y hTZETEET, OTVTD T 4 L ZIZL-T,
T—=E L E—ND T T 4w Ina—h T4 AENET,
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B = < EEtherchannel £S5V RRF LU R E—F /=22 H4 FRIOH

. o,
/ Internet )
S

Qutside

Global MAC
(blocked by OTV between sites)

Data Center '
Interconnect

Site MAC 2

Data Center 1 Data Center 2

OTVREDH&ERA N T T 7T 4 AZHONWTIE, V=T v RE—=RH¥A K NiZTAZY T
D OTV HE (95 —V) 2L TIIEIN,

ZX/\> K EtherChannel F S5 U ARF7 LU N E—FK /J—XYHX Y4 FEIDOH

WORFITIE, WEL—& LML — 2 OMICEE Sz () —AF T RFFAN) 2007 —F &
VE—DFENFIUZ2DOD T TALZ AUNRRNHELGEERLET, 7T AKX AN, DCI
BHOZ ZAZEHY 71k o TER SN TWET, £V A DT T AKX A8 F, NEER
KON D 2 23 K EtherChannels Z{# ] L Ca— /L A A » F 28 LE T, 4 EtherChannel
I, 77 AZHNOTRTOY ¥ — VAN SINET,

BT =L X —DONEIN—Z EAERL—2IZOSPF L, F 7 AT L | ASA %
WL ET, MAC LT, V—FDIP IZT_XTONL—FT—ETYT, DCLIZFE=2 A b
N—REENVEBTHZLICLY, FFEDY A FTTRTDI TAHX A NRE T LW R
D, N7 4w 23K T =2 X —RNICHEFRSIVE T, 7 7 A X BIEIFE OB & MERF
L7, ASA T AKX hoL— MME, EA FTRICTZ Y v ¥ T A—7 %87 5
VERHY ET, 12OV A bOTRCDT T AL AUNIEENEELEZSA, N 774
TIIHEN—2 D DCIRRBETHOY A Dy T AKX A NZELRET,
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2% K EtherChannel k5 Y ZRF7 LYk E— K /—24 92 44 rEos [

BV A NDOAAL v FOEEZIE, WOLDOEZDHIENTEXET,
e A FREIVSSWPC : 2DV F VAT, 7T— XX — 111 EDAL v T &AL A R—

N, T—=EFEv L FZ=20C0DAL v FuH A A =)L LET, 12DFF a3 LT,
BT =BV B =D FTAK 2=y MIa—hL ZA v FIEFICHR L. VSSVPC kT
74 v ZIEDCIERBA LET, ZOGHE, HBHiDIZEAEDOHZIIET —F ¥ —ITxt
LCar—AMcHiREnNEd, 77 ar & LT, DCABERBR N T 7 4 v 7 BENHT
X55A. 2=y FEDCIRRE CH T DAL v F IR CEET, ZOBE, v T 71>
TIFEEOT —F v o X =S 5720, DCLEIEFIZBEITT 572 OIIFRAIK T
7T

e XA FDOE—HINVVSSAPC : AA v T DILEMEEO DX, &0 A MI2oDRRD

VSSWPC T A VA b=/ TEET, ZORE, 7I7AX 2=y MI, mMiGOr—70
WAL FIRERFICER SN T =22 4 —1DOv X —vBLOINLOR =TIV AL
FIEEf SN T — 2o X —2 DY v —3 LT A3 K EtherChannel Z 5 L £33,
A% R EtherChannel [ZFEAMIZ T578E] L TWET, &7 —H/L VSSNVPC IE, A/

K EtherChannel %% b & —# /L ® EtherChannel & L Ciik L £,
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B = < FEtherchannel F5 VAT LU R E— KA —R kYR kA FRAOH

A /\> K EtherChannel F5 VAR7PLU M E—FA—XFY9 X~ HA FEDH

WO TIE, VA bOF—b U= —F L 200N Ry NI—27 (TFVr—var
Fy RU—=ZLDBXy hU—7) MICEBEINEZ (f—AFT =X MEA) 25007 —%%
VHE—=DENFINI2DODT TAL A UNBHBEEERLET, 7T AX A \E, DCI
BEOZ I ALZEE) o 712k THRESNTOWET, A FDr T 2Z AT, NP
TN o T 7V r—var Xy hU—27 L DBR Y b U— 7 Ol 72 A% K EtherChannels
ZEALTr =L 2L v FICHHE L £T, 4 EtherChannel (X, 7 7 AZ DT XTDY ¥ —
AR ENE T,

BV A FDF—F T = A JL—H %, HSRP72 EDFHRP Z{EfH LT, &Y A b TR UsEito
EMACT LR LIPT FLAZREMLET, MACT FLADTHENRT T v B 7 &S
L5120, F—=r 7oA N—HFDEEDMACT FL A% ASAMAC 7 KL R 7 —7 /LIZEIIC
BNTAZEEZBE#OLET, N0 NURRNE, A M OF— b T =AY A b
207 = oA LBETHHAEIC. TONT T 4y VHBASAZEBL T, WilA 4 —7
AANSY A F2ICHFEL LD & LT, MENRRETZAREMNH Y £9, 57— % VLAN I,
F—=N—=Ub A FT U AR— ML (OTV) (F7EFEERO b D) 2 L TH A MEICHE
EBENET, N T 740 I BT T2 —HBTCTHDIHEICNT 7 4 v 70 DCI %
LTV A MIEEINRNE T DITNE, 74NV FEZBNTEILERHY ET, 1D
DOV A NDOF— T = A —FPEFERRRIC - T25E6. N T 7 4 v 7 B™oYA Fo S — b
T AIICEEENDE LT AN EZEHIBRTARLERD Y £97,
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( Internet /
>‘_\k__/-’)\
Gateway Router: -~ Gateway Router:
.~ Virtual MACs and IPs &= - Virtual MACs and IPs
TNy (FHRP) (FHRP)

Spanned EtherChannel DB NW

Spanned EtherChannel

;@_ ol ASA Cluster ;@_ ;@_
-SESE== £\sAp ASA EEEEEE  ASA4 Emm=e
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Control
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I B jE

Spanned EtherChannel
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Swich  APPNW \L/]—"‘ﬁ'“"l’u—/ App NW Swieh

Data Center 1 Data Center 2

of ol o)

400783

vPC/VSS A7+ 3 N2 DWW TIL, A3 K EtherChannel 7 > AT L k F— K /J—AH
7 A YA FEOF] (100 2—) 2L T ZEN,
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HEEEHR
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ARP

9.12(1)

ASA TlE. Gratuitous ARP (GARP) /X7 v NEAEMLTAAL v F L7 AT T AL
T Fx B HITRHOREIR S L D Lz, &4 NOBEEIAMNAED Kb &
WA NIZE ST, 77—V MAC/IP 7 RLUAD GARP b7 7 « v 7 BNERIFICE
BEET, 7 TAEZNLERINTZTA FTEDOMACKEIOIPT RLRAE Ty
YA FEBFEDOMACT RLABIWIP T RLAZFEHTZDICH L, 7T AXT
ZIE LIy ML, 70—V MACT RLABEIOIP 7 FLAEFERALES, b
T4y N7 a—rLMAC 7 RLADLESICER SN WA, Za— Vb
MACT RLADAA v FTMACT RLADX A LT 7 MRFETHAEEMERH Y F
T, XALT T MMEIZT B —VMACT RVASND T 7 4 v I BRAAL v T T A
VITARNT I FABIRIIDIED T Ty T 4 7 N, AU D R T = R
SO Xa2 T4 FOMBERRET D ZENH Y £§, £ A3 K EtherChannel =
=y FBIXUOY A FMACT RLVAZ EIZY A FIDERETDHE. GARPINT 7 4V
N CHMZR Y £,

B/ H X7 (H : [Configuration] > [Device Management] > [High Availability and
Scalability] > [ASA Cluster] > [Cluster Configuration] > [Site Periodic GARP]~ 1 —/V
s

PIAZA L HF—T
A A TN AR
L. XU REN DR
RN A S Rt
H—T A ATHH S
nakoizz2vEL
776

9.10(1)

AVH =T 2 A ADAT —HATHNRAETDHE, ASAIIA VX —T = A A&[EEL
LCv—72 L, Z7I7AZ b=y N HIRT % % T health-check monitor-interface
debounce-time =~ > N¥ 72X ASDM [Configuration] > [Device Management] > [High
Availability and Scalability] > [ASA Cluster] B TH/E S 72 I U REFRHE L 3, 2
DOIERRIZ, ¥ 7 RO OBEIREBICET 524 4 —7 = A AZHEHA S D L DI
MO FE LIz, Tl 2T, F U ARED DBIRAEIZBAT L TV % EtherChannel D456
(AA v TFNYa— RENT, £EAA Y FRAEMT/e > TV 5 EtherChannel 72
E) L TR AR ERSTLZE T MO TAZ =y NOTRKR— DS
RABHENENWHIEBIZT T, VI7AX 2=y FETA U F—T oA AR T —FKR
SNDHOEHSZENTEET,

AR SNHEHEIZH Y £ A,

WEIEER AR ICEE)
HIZ 7 T A ZIZHEBN
95

9.9(2)

LIENE, 207 —REBICED 7 T AZ 2=y bR T AL DHIERSTHEL
Too ZOREZMR LIk, FEITY 722 ICHBNT2LERH Y E Lz, BUE
3, 2=y MET7H R T545, 1047, BEV20 53ORETY 7 2 ZIZABIIC
BZ2NEZRITLET, ZhODEFFRETE £, NOREICE, 77 ) r—ra
VEBIOZ A LT U N, FELET TV =gy AT —Z AR ERHY £7,

BB E 7213 S U721 : [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster] > [Auto Rejoin]
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3y
7 Z AL DEHEEDR |99Q) |2=y NZTL D7 T AZDEFMEOEN T U AR— b Ry 7 7 HHREZHERL T,
WRS U AR— K71 Ny Zyharyha— FL—rTho Wik o7c L X2y b Rr vy 7O
FanAye—T0 b MARFETED L OITR £ LT,
2%;%;&0};22@# FHLE 72 IXA T &z 2~ R : show cluster info transport cp detail
ASA 5000-X > U —X 99Q2) |ASA A v ¥ —T = A AEEENFEAELTND LR L, ASAS500-X &) — R Lo
XL A v —T = 7 AEMB=y MRHIBREND ETOT Y U AR Z2RETEHL TR F
A RA%FEHEE LTy — L7z, ZOBREICKY, 107 —T7 oA ZADEELY LV REICHRHTEET, T\
7§ % T DIZRE P hE VAR AR T L. BMRHOFRENEL 2D Z LICHERL TS, 1
TN o AR =T 2 A ADAT—Z ARFPRHET DL, ASAIFA v —T oA A&EEL LT
~—27 L, 7I7REnba=y NEHIBRT 2 ETHRESNEI VDB LES, 7
7 v b DT AT o AT 500 ms T, AR EOHFEIHIL 300 ms ~ 9B TT, Zo
FEREIZLARTIE Firepower 4100/9300 Tl T& £ L 7=,
R FE I3 S 72 - [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster]
27 ALY T OHA 199N | A FEOTEMIZEY, NTF 747 Ta—DONy I T v T F—F—XHICA—
~ RN F—=L3ROY A MIEPNET, ZOEEBIZE->T, 1 FOEFENLREINE
o
B E 721X W S 72 : [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster]
77 AH 2=y h~ |98(1) | 2=y b~V AT = v 7 ORI Z LV KOOI E T ET (r/IMEIX3B)

VAT o 7 EER
Do

VBTOR/IMEIZ S TLE, ZOMEIL. 2=y h AR Fx2v Pl AvbE—0 )
Ax¥—L%, A ba— )L T —=rDX—TTITATMHT—X L —rD/—h
E—MIEELET, "~ FeE—F2HTHE, 2 br—L 7L —2CPUDKR Y
XU TRATVa— ) T OBIEDOBELEZ TN, 7T A% v 7 OfFHENE &
JREMER ELET, REFEMARCERET D, 7 7RAFGIHY) V7 DA v E—Y
YITIT 4 ET A BHENT S EICERE LT EE N, RERMZEEET DRI
Ry NT—2 20T 5Z a8 LET, =L 20E. HARZEERBRORIC
3OD/N—FhE—hF Ay B—UNFEET DD, Z7I7AXGEY) 72 L THDH
=y "B RlO =y F~Oping NIREFFHIBLNIZE S Z & 28 LE T, REEE
Mz 03~07ICRELIERICASA Y 7 by =T 2 XU 7 L—RLESS, HFriln
BENTR—FENTHRNDT, ZORETT 74/ bDO3HITEY £,

WOMHE %2 LE L7z, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster]
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A N— | iEerER
ay

Tyl ua—hY |990) |T—=H B E DT -~ A%MEL, YA NI TAZ IV TDNTT 47

Y—var . F—4% EHERFT 272012, To b7 Zu—alB—rarE Ao cEET, BmE, Ly

YE—=DYA NET T PIXREDT A MND T T AR AU NR=ZLoTr— K AATZ A3, AT S

2B T DR E: TWET, L2l ASAIIEEDY A FDOA LV AR=IIT 4 LI X n—)L &%) 4T
I, T =BV EB—va ik, FiAEERICYA hor—hL T 4
VIR, EOVA MCUOIFERRER 70— )L T 4 LI Z LW BINDT 4 L7 X
O—/LNENZR D FT, TEELET 4 VI XBE—Y A MIFETHE X7 4 —
T UABRMELET, Fo, TORAENRK LGS, e— AT 4 LY ZILIE
CHA FTHLWEROHNEELZRBRLET, Fn—"ART VLI XL, JTAHK
AU N=DRIDOY A N CTEA SNDERD /T > NEZETL2HEIERIET,
WOME %2 LE L7z, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster] > [Cluster Configuration]

=T v RBLXOA,Y9.6(1) | 2,3 K EtherChannel D/L—F v K E— R TOHYA "HZ T AZ ) T DEFE. I A

> K EtherChannel &— MEBIDO MAC 7 RLARIZIMA T, A MEBDIP T FLAEZRETEH L1720

ROYA NEF O IP EFL7, YA FNIPT RLVAZEBMNMTAHZEICLD, 72— VULMACT RLANLOD

7 RLADR— ARP JEEZBIIET 272012, V—T ¢ 7 MBEDJRKIZ 72 Y 7H>Fa 72\ Data Center
Interconnect (DCI) B DBENZ L DA ——L A FT v AR— Mk (OTV) T
NAAZAD ARP BREEFEHTHZ DR TEET, MACT RLREZT 4 VZLES 57
WIZ VACL ZEHTE VWA A v FITIL, ARP REDNKLIE T,
WO % ZH LE L7z, [Configuration] > [Device Setup] > [Interface Settings] >
[Interfaces] > [Add/Edit EtherChannel Interface] > [Advanced]

ASA 5516-X TD 7 Z [95(2) |ASAS516-X 32 2=y K 7T A Y R— b TEHL9R0E LIz, BRIV

AHY T OYR— b ATIE, 22=y bDITTAZ Y U INT 7 50 b THEMEES R TWET,
EHEI7- ASDM EEITH Y FH A,

P4 "7 —=EtV |9.5(2) |Cisco Locator/ID Separation Protocol (LISP) ®7 —F7 7 F ¥ (X, T34 A ID %D

T A4 D LISP A > A~
7arv

BN B2oDERDF N T A= IHEEL, =BT E IS4 T |k
WXL CEEIIC LET, ASAIL, BITAEOLISP F 77 4 v AL, £
W —L VR T A2 ) ZEIEHTEEY, ASA T T AZ A=,
BAIOKR Y T N—2 ) b R = ETIIAT) R L—F ORO LISP k
T4 EREL, 7a— 4 —F—OFEGIETRY A NMIERELET,
WROBENEANEIEFEINE L,

[Configuration] > [Device Management] > [High Availability and Scalability] > [ASA
Cluster] > [Cluster Configuration]

[Configuration] > [Firewall] > [Objects] > [Inspect Maps] > [LISP]
[Configuration] > [Firewall] > [Service Policy Rules] > [Protocol Inspection]
[Configuration] > [Firewall] > [Service Policy Rules] > [Cluster]

[Monitoring] > [Routing] > [LISP-EID Table]
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Haes N— | BEEEIRER
av
Xy U7 JL—F 952) |¥x V7T 7 L— RELITAIFE PAT TliX, NATIZ 1 FEIZ 1 DOR— FE#HEZE|D Y
NAT OiffbiE, 7 =— TEEDLZOTIERL,, HFARAMIAR— 0T a7 Z2E0 YK CHZ LR TEET (RFC
A — =1 L TVASA 6888 AWML T X)) . ZOMEEIX, 7= — A —N"—BLWNASA 7 T AXD
IR T HATHAR—FEINET,
A hbanET. B SN FE I D £ A,
JFGAZY T hL—|95Q2) | T T ANV ERT, TRTDOLNVT TAZY T A X2 M, S DO FLL-LDA X
A xR OFRE A HE Y RPAMZ, FL—ARNy T FIZEENET, LV AL DA R FAD L —
e LL AEHIRT HT2DIZ, 7 TAZDOE/N L —RA LNV EFRETEET,
ERINTEMEITH Y EH A,
N—Fv K 7547 [95(1) |v—F v FE— RTlL, A% KEtherChannel V4 "7 5 2%V v T 5 EHT 52
7 F—)LF— D AN LRTEET, MACT RLRADTZ7 T v 75T, A F—T oA ADY
> K EtherChannel ™ A FHIDOMACT RUVARY A FOa=y F ETHETELLIIC, BT TAFZ A
N VA N N—=DH A NID ZRELET,
A= h CZ)‘H%’ Rl WOME %2 LE L7z, [Configuration] > [Device Management] > [High Availability
MAC 7" Rl and Scalability] > [ASA Cluster| > [Cluster Configuration]
AV =Tz A AET|95() | Ao H—T oA AEFT7 T AXHIEY > 7 DRLUTZ854A . auto-rejoin BifEE B A
37 7 ALY > v A ATEET,
3 - A
7 %E&,Pt G WO H ZE A L FE L7, [Configuration] > [Device Management] > [High Availability
auto-rejoin BIED ASA and Scalability] > [ASA Cluster] > [Auto Rejoin]
TITARDIAR~<A
2
ASA 7 T A X%, 9.5(1) |ASA 7 7 A& %, GTPvl BLO'GTPV2 A v AU v g &V R—bLET,
GTPvl & GTPv2 % -
EEIN-EIRITILY FHA,
Fe R LET VALY W T Y
ASAZ ZAX Y 7D |95() | 7T A2 ) o FFEREE, ASAIZT 74V F T, RESNTWAN—RT 2T £V 2—
N—=RU 2T EY a— L (ASAFirePOWER £ 2 —/L 72 Y) O~V A E=R Y o T E2ITWET, BED —
ILDANVAET=HR Y Ry 27 Y a— LDEEILL>T T z— LA —NR_"—% NI H—FT5ZLNEF LL
7 DN ROWGRIE, BV a—VDE=X Y T BT 4T MITEET,
WROMWmE%AZZ 8 LE L7z, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster| > [Cluster Interface Health Monitoring]
TCP#Ekt D7 T AL |9.5(1) | ZOMEEET, T4 LI X2/ w 77 v 7 7 a—{EROBRIEI X A i 8 E 7 v —

BLRIE

WZBET S TAREREE) 2P TEE T,

WO % E A LE L7, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster Replication]
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HEES IN— | HBEEIER
o3y
A B =T A AL 94(01) | ~AAEF=F Y NT A E—T A AT LA FZ—TNVERITTFT =TT
D ASA 7 T AH D~ HIENTEET, 774V FTHH, A= FF ¥, E. BLOE—~DOTITO
WVAE=H ) U TDA WA VA —T 2 ATNVAE=H ) TN, X —T N> TWET, ~JLA
bEIET v —7 F=H YU TIXVLAN Y 7 A v Z—T = A A, £721% VNI ° BVI 72 EOFFEA
Uzl H—=T 2 ATIXFITENTE A, ZITAZHIHY 7 OF=F ) TIIRETEE
Bl ZOV U TITFICE=HFAINTOVET, 2 2iE, BEHA LV F—T oA A7
E. WEUANDA v B =T 2 ADNNVAET=RY) T T =TT H LN
TEET,
WOMH %EA LE L7, [Configuration] > [Device Management] > [High Availability and
Scalability] > [ASA Cluster] > [Cluster Interface Health Monitoring],
DHCP V L—® ASA |94(1) |ASA 7 JAHX CDHCP YV L —%2RECTEET, 7747 h®DHCPER(X, 7T
75 AR T DY ATV RFDOMACT RLADNy VaZffiH LTI TALX AN |Zr— RKNT R X
A=k NWEFT, DHCP 7 A4 7 v B L O — e IZ R — F S TWEH A,
BRERINZEEIIHY A,
ASAZ S A7 T|94(1) |ASA Y G AZTSIPA VAT Vg UEBRETCXET, lfllve—3, £E0Da2=y
DSIP AV ART g FCERRCEF T (=R RXT v TDid) | T0O+FT—4% 7a—[ZFE L=
DY R— h =y MIEETAMERH Y £79, TLS X VB EITTR— SN TWER AL
ERINEmEILIH Y FHA,
NE Ry hU—27|932) | YA FORNEEXy NU—2 A= T oA L—FIC T AT L kN E—F
ASA 7 G AHX 77 A DI TAZEEANL (AKAA—AX M7 X MEA) | A FEICHE VLAN Z455E
T F—VEEx T ~ TEFET, A==V A FTF U AR— ML (OTV) OfFEHEZHELEL F308, 7F—
SLUART L N E— FNT A N—ZDEETHMACT FLABIOIPT RLARY A METRAZ VLA
RO A HEEA WE T RO S EEMEHTX £9, HSRP 7¢ & ® First Hop Redundancy Protocol
(FHRP) #MH LT, RIUBIEMACTY RLABIOIPT RLRAEZF — KT oA L—
2L F9,
ASA 7 528 Y 271293(1) |ASA 7 5 A2 & ) o ZIZ%tT % BGP W R— R BIENnE Lz,
fﬁémﬁ@ﬁ*_ WO & 28 L% L7z, [Configuration] > [Device Setup] > [Routing] > [BGP] > [IPv4
Family] > [General],
rZoAN_T LR [92() | T UART LU N 77 AT 74 —/L F— R TA K EtherChannel & — K Z i [

T— R TO5R L i
HINLIEIC 8 D 7 T A
AL ARDYFHR—F (P
A N

THE TTARE AN R DB RGPNIRETE L LIV E Lz, L—
Ty R 77447974 —/LE— KDA/X K EtherChannel T® Inter-Site 7 7 A% U
TV R —FENFEHA,

B XN/ ASDM HHILZH D EH A,
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RN TTAHVT 4
D HR—F

9.2(1)

—H DAL v TFIL, LACPTOX AT I v I R—FTFI7A4F VT 2% FR— KL T
FEAL (TIT4T7TBIORZ ALV D)  BAFTI v I R—= T I7A4F VT 4
T 4= NI T B LT, A% K EtherChannel & O H¥EZ S0 5 Z LN TE
HEITDFE LT, WOEBEFHIZHOHEI LERH Y 77,

IV TARFIHY 7 RADF Y FT—T T AL NTEE, L4F = 7 LB
FELRNWE SIS TA2MERB Y 3, 7T AZEHY /B TY XA L7 b E
NEZRTZ 7400 72F, ELVWIAT =y 7 FARRESNTOVERTA, L4T =
I LERFET DAL v FICLD, NI 74 v RN Ry 7SN AREERSH
£7,

R—=FF ¥R R RLVDE T Z A LT
VA=V EBZTIERD FE AL

RESNTNDLXF—TTITA47 A

WOMHE %A LE L7, [Configuration] > [Device Management] > [High Availability and
Scalability] > [ASA Cluster],

A3 K EtherChannel
TORBEOT 7T 4
7 VIOV R—k

9.2(1)

ASA EtherChannels [Zix K 16 [HOT 77 47 Vo 7 Y R— b T5E51C20FEL
77 A3 K EtherChannel TiZ% DEERENIEE SN T, vVPC D2 HD A A~ F TfEH
L. AT 397 B=bt TI3A4FVT 4 2T 4 £—T NI LEEHE, 7T AZ 2K
TIRRREDOT 7T 47 Vo7 &YR—rLET, AL vTFiE 16HOT 7T 47
Y > 7 @ EtherChannel % %R — F 350421 H Y £9 (] : Cisco Nexus 7000 & F2
J—=ZX10FHEYy A —FRy Fh EV2—) ,

8MDT 77 47 V7 &Y AR— T 5 VSS 72X vPC DAL v FDEEIE, AS
K EtherChannel IZ 16 HDT 77 47 Vo 7 R ETEET (AL v F IR S
AT 8 ) . PEkIX, VSSWVPC TEET 2356 Th > Th, A/ 2 K EtherChannel |
8BEOT 7T 4T Vo7 E8BODAZ L INA Yo7 LR —FLEHATLE,

Gx) A%y K EtherChannel T8 LV DT 7747 Vo7 aHAT 56
X, AF AL VU R TEEYA, O~RBOT /T 47 VT %
PR— T DI, AZ NS U O ZFTREIZT 5 cLACP ¥ A )
RV RN TIAF VT 0 %T 4 E— 7/1/_'9“5z\£735‘3?>@i?“0

WO %2858 L% L7z, [Configuration]>[Device Management] >
Scalability] > [ASA Cluster],

[High Availability and

ASA 5585-X D 16 D7
FAHE A NDYR—
K

9.2(1)

ASA5585-X M 16 2=y b 7 T AX B R—=FF2L9100E LT

ERSNCHEEIZH Y 5 A,
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ASA 5512-X, ASA 5515-X, ASA 5525-X, ASA 5545-X 38 X TN ASA 5555-X 32 =
NI TRAEEYR— T DLV EL, 22=y DI FTREZY U 70F, HEAR
TABVATIET 74V N CTA X —T 2720 £9°, ASA5512-X Tl Security Plus 7
A B ARADLETT,

B X7 ASDM HHiEH D £+ A,

ANIVA F T T
U7 DVSSEIW
VPCIZ K D AR—FD
Rk

9.1(4)

7 Z A BN > 7 3 EtherChannel & U Ca%E ST\ T (HELE) | VSS 7213 vPC
RTNEERLINTWDLEA, ~NA Tyl TE=F ) TICE> TEREREZEHD D
ZEMNTEES, —HDAA wF (Cisco Nexus 5000 72 &) Tix., VSSAVPC D 1 oD
=y R Yy MY U VERITEEITLE, TOAL v FICERINATND
EtherChannel A > /3— A4 L Z —T = A4 AN ASAIZKT LT T v P L SN 58560
BHVFETN, AL TFANINI T 7 4 v 7 DBPEINTWEHR A, ASA holdtime timeout
ZARME (0.8 72 &) ICRE LIZHA. ASA MR- TrZ T AX D LHEIBRS D ATHE
MERHY  ASAIZXF—TFT 547 Avt—2 20500 )>@ EtherChannel 1
VH—T oA ATEELET, VSSWPC~ILVAF v ZHEBER A 2 —T W2 T D &
ASAIX Y T A ZHIHY 7 DT D EtherChannel f > X —7 = A A TxF—TFT A4
T A=V 779747 LT, DR ELIRDAAL vy TFNRENEZFETED
TLEMERLET,

WOME %A LE L7z, [Configuration] > [Device Management] > [High Availability and
Scalability] > [ASA Cluster],

B0 B BN EIZ H
DY TARE AL RDY
A= (¥4 rHE) .
AR A v Z—T = A A
E— D&

9.1(4)

EHBA v H—T oA A= REFEHATDHE, 7T AKX AU\ & B B 72 50T
WWHRETE D L9100 F LT,

B X N7- ASDM HHILH D FH A,
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ASA 5580 B LY 9.0(1) |ASA 7 T AHX Y T HFIATDHE, KT8 D ASA 7/ NL—F{L LT, 1 >OimH
5585-X O ASA 7 T A FNAANZTHZENTEET, 7T AFIL, B—F A, 20T XCOFEHE (&
AN ., 2y NU—T~DOHHR) 22D~ T, BET A AL TEWAL—Ty

FBIOTEMEZER LET, ASAZ 52X U 7%, ASA 5580 35 L TF ASA 5585-X
THR—PENET, 1207 FAZNOTRCOL=y FRR—ET L, A= —
Ry 2T TH D ENMETT, FTAX I THRA X —T LD L XIZHHR— |
SNARVERED U A MZoOWTIE, a7 4 Falb—Yar A4 RE2BRLTLLES
W,

ROBEHPFEAELIEESINE L,

[Home] > [Device Dashboard] [Home] > [Cluster Dashboard] [Home] > [Cluster Firewall
Dashboard] [Configuration] > [Device Management] > [Advanced] > [Address Pools] >
[MAC Address Pools] [Configuration] > [Device Management] > [High Availability and
Scalability] > [ASA Cluster] [Configuration] > [Device Management] > [Logging] > [Syslog
Setup] > [Advanced] [Configuration] > [Device Setup] > [Interface Settings] > [Interfaces]
> [Add/Edit Interface] > [Advanced] [Configuration] > [Device Setup] > [Interface Settings]
> [Interfaces] > [Add/Edit Interface] > [IPv6] [Configuration] > [Device Setup] > [Interface
Settings] > [Interfaces| > [Add/Edit EtherChannel Interface] > [Advanced] [Configuration]
> [Firewall] > [Advanced] > [Per-Session NAT Rules] [Monitoring] > [ASA Cluster]
[Monitoring] > [Properties] > [System Resources Graphs] > [Cluster Control Link] [Tools]
> [Preferences] > [General] [Tools] > [System Reload] [Tools] > [Upgrade Software from
Local Computer] [Wizards] > [High Availability and Scalability Wizard] [Wizards] >
[Packet Capture Wizard] [Wizards| > [Startup Wizard]
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